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Budgets 
InLoox for Outlook enables you to create and manage your project budgets, so you always have an 

overview of your project’s financial status. 

To get to your project budgets open an InLoox Project and navigate to  on the Home tab.  
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Budget types 

Automatically created budget types 
InLoox generates two budgets automatically:  

• Expense (actual, time tracking)  

• Expense (plan, resources) 

Expense (actual, time tracking) is based on the time tracking entries in the InLoox tasks, the Expense 

(plan, resources) is based on the resources working on the project tasks.   

 

Both budgets are only automatically filled with budget items if they fulfill these requirements:  

1. You have created tasks in a project 

2. You have assigned time tracking entries to project-specific tasks, or have assigned resources 

to these tasks 

3. You have specified the effort for the tasks 

You can’t edit some elements of the budget items, such as group, units etc. If you want to make 

changes then you’ll have to make the edits in the tasks or time tracking entries directly.   

 

Budget types you can create manually 

Next to the two automatically created budget, you can also create four types of budgets manually:  

Planned Expense – Use this budget type to create a budget for your planned expenses based on the 

purchase price. 

Actual Expense – Use this budget type to create a budget for commissioned orders or already 

received services. The sum of the budget items will be calculated based on the purchase price of the 

group. 

Planned Revenue – This budget type is used to create a budget for planned revenues based on the 

sales price of the respective group.  

Actual Revenue – Use this budget to create a budget for already invoiced services or for services the 

customer has already received. The sum of the budget is based on the sales price of the respective 

group.  
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Link documents to budgets/budget items 
It is possible to attach an Excel table, a contract or any type of documents to project budgets or 

individual budget items. This enables you to establish better comprehensibility, e.g. for invoices.  

 

1. To attach a document, click on a budget or budget item. 

2. In the side panel under Documents, you can search and add documents. To add a new document, 

click Browse. Then you can select the corresponding document from your computer. Once you click 

Open, the document is linked to the budget/budget item. 

3. If you already have available documents, they will be displayed. You can select the desired 

document by mouse click. 

4. The Advanced field opens a dialog box. Here you have the possibility to search for documents in 

more detail. You also have the option here to add further documents via New file (e.g. a file, file link 

or an Internet link). 

 

Create a new project 
This chapter explains step-by-step how to create a new project. For starting a new project you will 

need specific user permissions. If you do not have the permission to create a new project yourself, 

you can submit a project proposal to be approved by your supervisor or project manager. This 

workflow process provides increased planning security for you and an improved project portfolio 

insight for the responsible project managers and executives. For more information on permissions 

browse the articles: how to set user permissions and user permission options.   

Additionally, you can use the search feature within the projects to easily find specific project 

information.  

Activate the "Fixed Deadlines"-Feature on the management page for new or running projects. This 

highlights all activities that exceed the project end date (defined on the management page) in a red 

shaded field in the project plan. 

 

How to create a new project  
In the following description we will explain step-by-step how to create a new project with InLoox for 

Outlook. (Therefore you will need specific user permissions. If you do not have this permission, you 

can submit a project request.)  

1. Start from the project list, which gives you an overview about all your projects. 

2. To create a new project, click on the Plus icon New Project in the upper left corner. 

 

3. The management form will open. 



 9 User Manual  InLoox 11 for Windows/Outlook 
Professionals 

 

 

Here you can enter the basic project information: 

 

• Name your project. 

• The project number is automatically generated. But administrators can customize the project 

number and the number format in the InLoox options.   

• Choose the responsible division and a category for your project. Administrators can 

customize the division structure as well as the project categories in the InLoox settings.  

• Assign a customer to your project. Please note Administrators can edit customers and 

customer numbers in the InLoox settings. 

• To assign a picture to your project click on the grey InLoox Logo. Locate the picture you want 

to add and double-click on it. 

4. By assigning project team members (project team, project partners, customers etc.)  to the 

project, your employees will know for which part of the project they are responsible.  
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By setting up a project team, you define the access permissions for the project. (For more information 

on how to share permissions or add users to the list, please see Set user permissions.)  

Moreover by assigning project roles, you define the role permissions of the chosen person.  

Select the project manager and team members from your Address Book (InLoox address book, 

Microsoft Outlook address book or exchange server address book): 

• Select one or more project managers by double-clicking on the entry and click on Apply. 

• Select one or more team members by double-clicking on the entry and click on Apply. 

5. Select start and end dates as well as the status of the project. 

 

Please note Administrators can individually define the project status in the InLoox Settings.  

6. Use comments to leave any additional information on the project. 

You can change the appearance of the comment with InLoox features on the Format tab. Customize 

your comments with different fonts, colors, sizes etc. … 

 

• Hyperlink: If you want to link a file, website or picture, mark the relevant part of your note 

and click on Hyperlink. Select the file in the address field or enter the URL of a website. Then 

click on OK. 

• Symbol: Choose a symbol, which is not on your keyboard or is a special character.  

• Picture: Browse the folder where the picture you want to add is saved, select the picture and 

click on Insert. You can resize the picture directly in the comment. 

7. To save your comment click on Post Comment. 
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Your file is now linked to the note and can be accessed by pushing the Ctrl-button and clicking on the 

link. 

Additionally, you can send your comment via email to the project manager or other team members. 

Click on Notify and select a contact from the address book. 

Please note Administrators can define in the InLoox settings, if notes are sent via email, as Outlook-

tasks or as Outlook meeting requests. 

8. Add other project information by using InLoox features on the Edit tab: 

 

• Fixed Deadline: If necessary, mark your project as a deadline project, such as trade fair 

appearances. For deadline projects, the project end date is highlighted in the planning by a 

red line. 

• Archived: When you archive the project, you automatically move it to the archive.  

• Lock Project: Administrators can use this command to protect the project from changes.  

• Priority High/Normal/Low: Set the urgency of your project. Later, the projects can be sorted 

in the project list based on the priority. 

9. Click on Save and Close in the start ribbon when you are finished. 

 

How to submit a project request 
When you don't have the user permission to create a new project, you can submit a project request 

to be approved by your supervisor or project manager. For more information on permissions browse 

the articles: how to set user permissions and user permission options. In the following we will explain 

step-by-step how to submit a project request: 

1. Start from your Outlook Inbox. 

2. After that you can see the project list, which gives you a short overview about all your projects.  
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3. The management form will open. 

A notification will pop up (yellow highlight) on the management form to inform you that you are not 

starting a new project but editing a project request. Click OK to edit the new project request. 

• Enter the basic project information. Therefore read the chapter How to create a new project.  

• Click on the Reviewer button in the staff area to select somebody to release your project 

request. Select the responsible person by double-clicking on the entry in the address book. 

  

4. Click on Safe and Close when you are finished. 

The reviewer you selected will receive your project request submission for approval and the project 

request will be included in the tree structure of the InLoox project list.  

 

Dashboard view 
The dashboard allows you to view many areas of your projects at a glance and provides a quick 

overview of the current project information without having to open the individual projects.  

 

The view can be configured individually for each user.  

 

TIP As the dashboards provide very extensive and sometimes complex functions, we recommend our 

dashboard training course. 

Find out more at On-site workshop: Dashboards and reports or Dashboard and report training at the 

InLoox training center. 

Creating and managing dashboards 
1. first open the Dashboards view using the following options: 

 

• In the Outlook client, click on the InLoox view and in the tree structure on Dashboard  

• In InLoox for Windows, click on Dashboards in the lower navigation bar 

2. to create a dashboard, select the New dashboard button in the New section of the top ribbon  

3. the Dashboard Designer opens and you can start creating your dashboard template.  

4. to save a dashboard template, select the Save button in the top ribbon. It is also possible to 

save an existing template as a new template. To do this, select Save as.  

 

 

Explanation of the dashboard elements 

Pivot table 
The Pivot dashboard element is a table that displays multidimensional data in a simple table.  

Values: This area displays data elements that are used to calculate the data in the pivot table.  
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Columns: This area displays data elements that are used for the column headers.  

Rows: This area displays data elements that are used for the row headers 

Layout & style: If columns and rows contain many data elements, their headers are grouped 

hierarchically. You can expand or collapse these groupings. To do this, switch to the Layout &amp; 

style area in the ribbon and open the Initial state drop-down menu. 

 

Table 

The dashboard element table contains simple columns. These are filled via the selected fields of the 

data sources. The names of these fields are used here as column headers.  

New columns: This area displays the data elements that are used for the column headings and 

therefore the content of the respective column. 

Sparkline: This area shows data elements that indicate the change in totals over time.  

Layout & Style: Here you can join rows or cells, edit separator lines and switch alternating row colors 

on or off. 

 

Diagram 

The dashboard element chart displays a simple bar chart of the desired values. The values can be 

used as totals for this purpose. 

Values: This area displays data elements for the Y-axis. 

Arguments: This area displays data elements for the X-axis. 

Series: This area displays data elements whose values are used for series. These values are used as 

headings in the legend. 

Layout & style: Various settings can be made here for the legend of the chart, the display of the bars 

and the respective axes. It is also possible to rotate (transpose) the chart.  

 

Circle 

The Circle dashboard element displays a simple pie chart of the desired values. The values can be 

used as totals for this purpose. 

Values: This area displays data elements that define the respective portions of circle segments.  

Arguments: This area displays data elements for the headings of the circle segments.  

Series: This area displays data elements whose values are used for series. These values are used as 

headings in the legend. 

Layout & style: The position and content of the label, the design of the diagram and the desired 

colors for the circle segments can be set here. 

 

Measuring device 
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The Meter dashboard element displays values in the form of a meter diagram.  

Measuring devices (current, target): This area displays data elements whose values are calculated in 

the measuring devices. Data elements are arranged in containers where up to two elements can be 

displayed. The first data element indicates the current data, the second element the target data. If 

two elements are present, the measuring device shows the deviation between target and actual 

values. 

Series: This area displays data elements for the headings of the measuring devices.  

Layout & style: The style of the measuring devices and their labels can be set here.  

 

Maps 

The Cards dashboard element displays values in the form of small cards.  

Cards (current, target): This area displays data elements whose values are calculated in the cards. 

Data elements are arranged in containers where up to two elements can be displayed. The first data 

element indicates the current data, the second the target data. If two data elements are present, the 

meter shows the deviation between target and actual values. 

Series: This area displays data elements for the headings of cards.  

Sparkline: This area graphically displays the date dimension within the cards based on the selected 

data source. 

Layout & style: The names and arrangement of the cards can be edited here.  

 

Area filter 

The area filter dashboard element can filter other dashboard elements. It represents a diagram with 

sliders. These sliders can be used to filter the values on the argument axes.  

Values: This area displays data elements for the Y-axis. 

Argument: This area shows data elements for the X-axis. Filtering is based on these values. 

Series: This area displays data elements whose values are used for series.  

Layout & Style: Here you can edit the series type, the colors of the element and the desired time 

period, among other things. 

 

Pictures 

The Images dashboard element displays imported or uploaded images.  

Attributes: Bound images can be integrated using attributes. For example, it is possible to display a 

specific image based on a different value. 

Layout & style: Among other things, the display of the image and its alignment can be set here.  

 

Text field 
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The dashboard element text field displays simple texts in the dashboard.  

Values: This area displays data elements for the text to be displayed. InLoox allows multi-line texts. 

Layout & Style: Static text can be edited here. You can also add fields from the data sources to fill the 

text field dynamically with texts (e.g. project manager). 

 

Designing dashboards with the Dashboard Designer  
To design a dashboard, open an existing dashboard via the Open Designer ribbon button or create a 

new dashboard via the New Dashboard ribbon button. 

1. first open the Dashboard Designer and select the Tasks data source on the left-hand side. The 

corresponding properties and fields of the tasks are now listed below.  

2. create a simple table using the Table ribbon button and drag and drop the following fields from the 

data source to New column: 

Project_Name 

TaskItem_Name 

Resource_DisplayName 

TaskItem_WorkAmount 

 

3. right-click in the table to open the context menu and select Edit names. In the dialog that now 

appears, you can adjust the table name and the headings in the column headers. Then confirm with 

OK. 

4. now create a pie chart using the Circle ribbon button. Hold down the left mouse button next to the 

Circle 1 heading and drag the pie chart element to the desired position. A blue bar shows you where 

the element will be placed. Then release the left mouse button to place the element above the table. 

5. at the blue marked edges you can drag the height to the desired size with the mouse.  

6. now drag the TaskItem_Name field to the Value area, the TaskItem_IsDone field to Argument and 

the Resource_DisplayName field to Series. The dashboard element now spans several pie charts as 

follows. You receive one pie chart per employee. This sets the number of items to values that are 

present in TaskItem_IsDone (here there are two: True and False). The size of the respective circle 

segment is determined by the number of tasks (counted via TaskItem_Name).  

7. now select the Filter elements button in the top ribbon and add List field. Place this on the right-

hand side of the dashboard, just like the pie chart element before. The width of the list box can now 

be changed using the blue borders. Now drag the Project_DivisionName field onto the Dimension 

field of the list box. 

8. now save the dashboard using the corresponding buttons in the ribbon and close the Dashboard 

Designer. 

9 The dashboard is now ready for use. You have your task list at the bottom and the pie charts above 

it, which show the completed vs. uncompleted tasks per employee, as well as a filter for the 

departments on the right. 
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Filters 
On the Data tab, you have the option of defining filters. 

Main filter (master filter) 

It is possible to use any field from a data source as a filter for the entire dashboard (main filter). You 

can select the elements for the main filter area (charts, pie segments, table cells, etc.) to filter the 

data according to the selected values. 

The main filter supports two selection modes. These can be found in the respective dashboard 

element in the upper ribbon in the Data area: 

• Multiple allows you to filter across multiple elements at the same time. To activate the filter, 

click on Multiple master filter. 

• Single allows you to use only one element as a filter. If this mode is active, the default 

selection is set as the main filter element. You can only change the selection, but not delete 

it. To activate the filter, click on Single master filter. 

 

 

Cross-data source filtering 

Since InLoox 11, it is possible to use cross-data source filtering of dashboard elements. This is used to 

filter dashboard elements that are linked to different data sources. To use this type of filter, you must 

enter the field that is to be filtered later in the dashboard elements to be filtered. 

 

Drill-down 

You can use the drill-down function to change the level of detail of dashboard elements. The drill-

down function shows the details, the drill-up function shows general information. To return to the 

original level, use drill-up or the context menu. 

 

Documents 

Add and edit project documents 
Work with file links to save storage space and avoid duplicates. File links don’t occupy storage space, 

as documents aren’t saved directly in Microsoft Outlook or on the Exchange Server.  

Please note The access permissions of the original document still exist in InLoox equally whether you 

upload the document or work with file links. If you add a file from a protected network folder or 

SharePoint store to the InLoox storage, still only authorized users can read and update it. Therefore, 

always take the access permissions of the original document into consideration, when uploading it to 

the InLoox storage. 

   

How to add a document 
1. Open an existing project and click on Documents in the Start tab. 

2. Click on the Edit tab and then on the arrow icon below New: 
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Choose between: 

• New File: By using this feature, you can upload a document to the InLoox storage and save it 

to the project folder. When the Windows Explorer opens, select the document and click 

on Open. 

• New File Link: By using this feature, you can create a link to the storage place of a document. 

The document isn’t uploaded and doesn’t occupy any storage space. When the Windows 

Explorer opens, select the document, and click on Open. 

• New Internet Link: By using this feature, you can add for example web addresses. After you 

have clicked on New Internet Link, a side panel opens on the right side. In the URL field you 

can save the web address.   

3. Afterwards the new document is displayed in the document list of your project:  

 

NOTE You can recognize the file link by the fact that the path is displayed in the Sourcefolder column.  

  

How to edit a document 

1. Choose the document you want to edit from the document list.  

2. Open the Edit tab and click on Edit. A side panel opens on the right side. Here you can enter 

important information regarding the document.  

3. Add information in the Basic Information area. 

• In the field File name you can see the name of the document. You can’t edit this field.  

• The State field allows you to leave notes about the processing status like in 

progress or completed. 

• In the Description field you can save all important information regarding the document. 

InLoox provides you with the various formatting features. For more information see 7. in  How 

to create a new project. 

4. When you have finished editing the document, close the side panel on the right side next to 

the Basic Information area. Your changes will be saved automatically. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/create-a-new-project/how-to-create-a-new-project/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/create-a-new-project/how-to-create-a-new-project/
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The document list in a project  

You can drop all important documents regarding your project in the document list. How to open the 

document list of a project: 

1. Double-click to open an existing project. 

2. To open the document list, click on Documents in the Start tab.  

   

Features on the Edit tab 

 

• Open: To open a document, choose one from the list and click on Open. You need specific 

user permissions for this action. 

• Download Document: Select a document from the list and click Download Document. The 

download folder in the Explorer opens - this is where the document was saved. 

• Replace Document: Select a document from the list and click Replace Document. You can 

now replace this document with another one. Attention: this is only possible if you have 

previously uploaded a file (and not if you have only uploaded a file link). 

• New Folder: Choose a folder from the document folder tree structure on the left and click on 

New Folder. A subfolder of the selected folder is created. 

   

Features on the View tab 

 

• Expand all/Collapse all: Change the view of the document folder tree structure by clicking on 

Expand all/Collapse all. 

• Select Fields: Filter the document to quickly find needed information. Click on a field in the 

dialog box and frag it into the column headers. To reset the field, click on the field in the 

column headers and drag it into the empty space below the document list.  
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Information rules 

Document folder view: 

• The entry All documents displays all documents which are saved within the project. 

• The entry Favorites displays all documents which have been marked in the ribbon as 

Favorites. 

• The entry Project folder displays all the documents of the project file store excluding 

subfolder content. The Project folder can contain subentries by the means of a tree structure, 

representing the physical structure of the file store or the SharePoint system.  

NOTES 

• Use the filter feature to quickly find needed data. For more information see Search and filter 

in a project 

• If a lock icon is displayed in the document list, you have no reading permission. In this case no 

document will be displayed in the list.  

 

Install InLoox On-Prem 

If you want to test or have purchased the locally installed edition InLoox On-Prem, please download 

the whitepapers for the installation of the InLoox Apps and the InLoox On-Prem Server 

here: www.inloox.com/products/documents/. 

On the InLoox website at www.inloox.com/support/download/produktdownload  please download 

the InLoox On-Prem Server Installer file and the Apps Installer file. 

 

Global task view 
Content of the global task view 
In the global task view, you see all tasks you have a reading permission for. The task list shows both 

project-related and personal tasks. The InLoox Administrator can set and change permissions in 

the InLoox settings. 

Tasks that are overdue appear in red. 

 

Create, edit and delete tasks 

Create and edit tasks 

To create a new task, click New task on the Start tab in the ribbon. You will be automatically entered 

as the responsible resource for this task. 

 To edit this task further, click Edit on the Start tab in the ribbon. 

1. In the page panel on the right, you can now enter a new name for the task as well as a 

description of the task. 

2. You can also specify the amount of time you plan to spend on completing the task. By default, 

one working day corresponds to 8 hours. Using the arrow to the right of Workdays, you can 

set whether the amount of time should be specified in workdays, hours or minutes. 

https://www.inloox.com/products/documents/
https://www.inloox.com/support/downloads/product-releases/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/inloox-settings/
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3. A personal - i.e. project-independent - task must be assigned to a resource. If you do not care 

about the completion yourself, you can assign it to another resource. A click in 

the Resource field offers you a quick selection of frequently used project resources, a click 

on Address Book in the window that appears during resource selection opens the global 

address book. A task can be assigned to only one resource to ensure unambiguous 

responsibility. 

4. You can specify in which time frame the task should be completed (start and/or end), but you 

don't have to. 

 

Assigning a task to a project 

By default, tasks you create in the cross-project project list are personal tasks and not assigned to any 

specific project. However, you can change this. 

1. Click the task you want to assign to a project, and then click Edit on the Start tab of the 

ribbon. 

2. The page panel will open. Here, under Assignment, click in the Assign to project field. 

3. A list of all projects for which you have permissions now opens. Select the desired project and 

confirm with Apply. 

As soon as a task has been assigned to a project, a reference to the project appears in the right-hand 

side panel when editing. You can click on the project name to go directly to the project. If the task has 

been assigned to an activity in the Gantt schedule, the activity determines the time frame (start and 

end) of the task. However, you can change it manually as long as it is not temporally outside the task.  

 

Notifications and comments 
Every user can define for himself in the user settings if and when he wants to be notified about an 

upcoming task. 

1. In Outlook, click the File tab, then Settings under InLoox. The Settings window opens. 

2. Now click on Personal in the navigation bar on the left. 

3. Now you can define the frequency with which you want to receive notifications.  

Important: The responsible resource will automatically receive a notification when something 

changes in the task. 

The Notifications field is intended to notify additional people, such as the project manager. The arrow 

offers a resource quick selection, a click on the three dots opens the global address book.  

If you want to convey more information about the task, you can add comments to the task. To do this, 

click on the Comments tab at the bottom of the page panel for editing the task: 

You can deposit people who should be notified about new comments on the task.  

1. Enter your project comment. 

2. If you want to notify someone about it, click in the Notify field. Here you can either use quick 

selection to choose the resource to notify or alternatively open the global address book and 

find the appropriate people here. 
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3. Then click on Add note. 

You can also create comments with notifications for tasks without project reference.  

How people are notified is set by the InLoox administrator in the settings.  

 

Marking tasks as done 

You can mark completed tasks as done directly in the task list. There are several ways to do this:  

• If you have the Completed column (with the green checkmark) in your task list, you can mark 

the task as done by clicking on the checkbox. 

• Alternatively, you can also right-click on the task in your task list and select Mark as Done in 

the context menu. For project-related tasks, you can distinguish whether you want to mark 

only the task or also the task in the project plan to which the task belongs as done. 

• The same function is also available in the ribbon on the Start tab. To do this, click on the 

desired task and in the ribbon on Mark as done. 

Marking tasks as done has the following effects: 

• When you mark a task as done, it disappears from your task list with today's overdue and 

open tasks and is displayed as a completed task. 

• For tasks with a project reference, the completion of the task is reported back to the project 

and is included in the project progress calculation. 

• If you have set notifications for the task, the person(s) will be notified about the completion 

of the task.  

• If you as the project manager mark a task as completed for which you yourself are not 

entered as a resource, the responsible resource will be informed automatically.  

 

Delete tasks 

You can delete tasks by clicking on the corresponding task in the list and then clicking  Delete in the 

ribbon on the Start tab. This function is also available in the context menu, which you can reach by 

right-clicking on the task you want to delete. 

When you delete a task, the people for whom you have set up notifications will be informed about it. 

If you, as a project manager, delete a task for which another resource is responsible, then that 

resource will be notified about it. 

Note: The deleted tasks are irrevocably removed, you cannot restore them.  

Tip: If you want to delete several tasks at once, you can do it with Multiselect. To do this, hold down 

the CTRL key on your keyboard and left-click on the tasks you want to delete. Now select Delete in the 

ribbon. 

 

Filter options 
In order to be able to edit the task list in a more targeted way and to better find your way through a 

large number of tasks, InLoox offers you various filter options.  
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When you move the cursor over a column heading in the task list, a small filter icon appears in the 

field. Click it to filter according to the respective category. 

For example, if you want to see only your own tasks, click the filter icon in the Resource column 

heading. A box will open where you can put a check next to your name. You can also set several 

checkmarks at the same time. The filter will be applied to the project list accordingly. 

To remove the filter, click again on the filter icon in the column header. In the window that opens, 

select Delete filter. 

  

Analytical filter 

In addition to the filtering options mentioned above, advanced filtering options are available via the 

analytical filter. The analytical filter can be found on the Start tab in the View section under Filter. 

 

Customize the list view 
To customize your list in the way that makes the most sense for the way you work, there are several 

functions available: 

  

Add and remove fields 

The task list offers you a variety of information that you can add or remove from the list in the form of 

table columns. 

To do this, click the right mouse button in the header and click Column selection in the context menu 

that opens. If you want to add one of the fields to your list, place a check mark at the respective 

position in the newly appeared window with the possible columns.  

  

Group 

To group the tasks according to a certain criterion, drag the field you want to group by into the 

Grouping field above the column headers. 

If you click on the arrow next to the grouping criterion, you can decide whether to sort in ascending 

or descending order. 

Here, too, there is another filter option: If you move the mouse over the grouping criterion, a small 

filter symbol will appear. If you click on it, you can further narrow down the grouping criterion.  

  

Sort 

You can additionally sort the task list by clicking on the column header you want to sort by. Click 

again, then the sort order will change. 

  

Conditional formatting 
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You can also format the task list according to rules you define using Conditional Formatting. You can 

find this feature on the Start tab in the View section. How to best work with conditional formatting is 

explained in detail in the Conditional Formatting chapter. 

 

Save and re-use views 
When you have compiled your task list in the way that is most useful to you, you can save this view to 

the database and make it available to other users. 

To do this, click Save as new view on the View tab.  Now you can give the current view a name. You 

can also decide whether this view should be available to all InLoox users or only to you.  

The saved view is available in the Outlook folder area on the left side under Tasks.  

Adjustments to your default task list are automatically saved locally on your computer and are 

available to you automatically the next time you use the task list. Only changes to additional views 

need to be saved separately.  

 

Track time efforts 
You can also track working times directly out of the task list. Click on the task on which you spent the 

working time. Then click in the Ribbon on the Home tab on the Track Time button. 

Learn more about tracking working times in the chapter Time Tracking. 

 

Refreshing tasks 
If many projects are created in InLoox, then new tasks are created permanently and existing tasks are 

modified or even deleted. 

To always be up to date, you can update the task list manually by clicking Refresh on the Start tab in 

the ribbon. 

 

Task list in the outlook side panel 
To have an even better overview of your InLoox tasks while working in Outlook or in the cross-project 

areas of InLoox, you can also display the task overview in a side panel to the right of any Outlook 

view. 

To show the side panel, click the InLoox tab, then Task List. To hide it again, you can go the same way 

or click the small cross at the top right of the page panel. 

Click anywhere in the side panel to activate the Tasks tab, where you will find all the functions you 

know from the cross-project task list in full-screen mode. 

Please read the Global Task View chapter to learn how to use these functions and how to customize 

the contents of the task list. 

 

 

 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/global-task-view/
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InLoox settings 
Since InLoox v11.0, the InLoox settings can only be accessed in InLoox Web App  

PLEASE NOTE Administrator permission 

To access the InLoox settings, you need administrator permissions for your InLoox account. Users 

without administrator permissions can only access the personal settings for notifications and the view 

mode of InLoox Web App. 

1. In InLoox Web App, click on your profile picture in the bottom left corner. 

2. Now click on Account Settings. 

 

Now you can define the general settings for the entire InLoox account.  

 
The InLoox options provide various possibilities to edit the customer number. In the customer 

number area you also can define the rules for the number format. 

 

Install InLoox On-Prem 

IMPORTANT Please note that Outlook must already be installed and fully operational before you can 

install InLoox On-Prem. The installation usually takes no longer than five minutes per client.  

For the installation of InLoox On-Prem, a step-by-step guide in our Whitepaper InLoox 11 Server 

Installation will help you. 

TIP In our Support center you will find assistance in solving installation problems.  

 

 

https://app.inloox.com/
https://edge.inloox.com/content/download/98998/2480570/file/InLoox+11+-+Server+Installer+%2821112023%29+-+EN.pdf
https://edge.inloox.com/content/download/98998/2480570/file/InLoox+11+-+Server+Installer+%2821112023%29+-+EN.pdf
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Functionalities of InLoox for Outlook Modern Add-in 

Set up the InLoox for Outlook add-in 
There are different ways to load the add-in into your Outlook. Please refer to the installation guide.   

First steps in the InLoox for Outlook add-in: 

1. Click on Open InLoox Add-in in the Outlook menu at the top. The InLoox for Outlook side 

panel opens. 

2. You can pin the side panel so that it is always available. 

3. Log in to your InLoox account. Do this as usual, either with the e-mail/password combination 

or via your Microsoft 365 access, depending on the setting you have chosen.  

4. That's it! You can now see your data with your current and upcoming tasks in the side panel.  

 

Structure of the InLoox for Outlook add-in 
The InLoox for Outlook add-in equips your Outlook with a side panel. 

 

This side panel serves as your personal workspace, providing you with a comprehensive overview of 

your current and upcoming tasks. The tasks are sorted according to their due date so that you can 

easily see which tasks have priority. 

At the top, you can also see which e-mail is currently selected and whether you are currently tracking 

the time for a task using the stopwatch. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/here-you-can-find-inloox-in-outlook/load-inloox-for-outlook-modern-add-in/
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You will see two small icons at the top right: 

• Globe icon: This opens the InLoox web app in the browser. 

• Gear icon: This takes you to your profile, the account settings, you can invite users and switch 

between accounts if required. 

Create, edit and complete tasks 

Create new tasks 
You have several options for creating tasks: 

1. Direct creation of a new task without e-mail reference: 

• In the side panel, you will find an empty field directly above the task list.  To create a new task 

without referencing an email, simply type the name of the new task into this field.  

• Then click on the blue button with the tick to the right of it to create the task.  

• You can now open and edit the new task in the task list. 

2. Creation of new task based on a selected email: 

• Select the email that is to serve as the basis for the new task. Info This is displayed in the side 

panel under "Current item". 

• To create the task, click on the blue button with the tick directly to the right of the "Current 

item". 

• A task is created with the subject of the email as the task name. The content of the e-mail is 

automatically transferred to the task description. You can also recognize the connection of 

the e-mail to a task by the marking of the e-mail with the category "InLoox". 

3. Suggestions for tasks by the InLoox AI Assistant: 

• The InLoox AI assistant can be used for emails that potentially contain several tasks. To do 

this, select the relevant email from which you would like to receive task suggestions.  

• Click on the button AI Assistant. You will then be given suggestions for possible tasks, 

including an estimated effort and a recommended due date. To accept a suggestion, click on 

the OK button next to the suggestion. 

• You will now find the task in the task list and can edit it with a click.  

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/here-you-can-find-inloox-in-outlook/functionalities-of-inloox-for-outlook-modern-add-in/#New%20IFO%20-%20Edit%20tasks
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Edit tasks 

Here you can find out how to edit tasks efficiently: 

1. Open a task: Click on the task in the task list that you want to edit. This opens the task detail view.  

2. Edit the task: In the opened view, you can edit the task as usual. All functionalities that are also 

offered in the InLoox Web App are available to you. The editing options include, for example: 

• Adjusting the start and end date: Define the time frame of the task by adjusting the start and 

end date according to your planning. 

• Enter an estimated effort: Estimate the effort required to complete the task and enter it. 

• Add a description: Provide the task with a detailed description to clearly communicate the 

context and subtasks. 

• Project assignment: Select the project to which the task belongs. 

• Comments: Leave comments on the task to share additional information or facilitate 

communication with the team. 
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Info For detailed information on project-related tasks, we recommend the help article Edit Tasks » 

   

https://www.inloox.com/support/documentation/online-help/inloox-web-app/11-0/all-topics-inloox-web-app/tasks/project-tasks/edit-task/
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Check off completed tasks 

Checking off completed tasks is a central component of task management. It allows you to keep track 

of completed and outstanding tasks. You have various options for marking tasks as completed:  

1. Check off directly in the task detail view: 

• Open the task you want to mark as completed by clicking on it.  

• Within the task details, you can mark the task as completed as usual by clicking on the white 

round circle next to the task name. 

2. Check off in the task list: 

• You can quickly mark a task as completed directly in the task list by clicking on the white 

round circle to the left of the task name. It is not necessary to open the task beforehand. 

• After clicking, the circle is marked with a green tick and the task is completed.  

Info Completed tasks are shown crossed out at the end of the task list. This gives you a clear overview 

of the tasks you have completed on the current day. 

   

Document management 
Save emails and attachments in projects 

PLEASE NOTE Since InLoox 11.17, you can chose to save emails as .eml-files. This will also save 

attachments as they are in the .eml-file.  

If you would like to save your emails and/or email attachments in your InLoox projects, proceed as 

follows: 

1. Navigate to the Documents tab in the InLoox for Outlook side panel. 

2. Select which documents you would like to save, e.g. the entire email (in PDF format or eml-

format) or only individual or all email attachments. 

3. Select an existing project in which the documents are to be stored. Alternatively, you can also 

create a new project. 

4. Select the target folder. You can also use the search function or create a new folder. 

5. Click on OK. A progress bar is displayed at the bottom of the screen showing the upload 

status of your documents. 
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Save email attachments in tasks 

You can also store your email attachments directly in a specific task: 

1. Open the task in which you want to save the document. 

2. Now you can drag and drop the document onto the task. It is then saved there. 

   

Time tracking of tasks 
If you want to track the time of tasks, you have various options for doing so:  

1. Using the stopwatch in the task overview: 

• You do not need to open a task to start the stopwatch. In the side panel, there is a play 

button next to each task in the task list, which you can use to start and pause the stopwatch 

at any time. 

• Info The top edge of the side panel shows if the time is currently being recorded and for 

which task. 
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• To book the recorded time on a project, open the task and confirm the time recording by 

clicking on the tick next to the stopwatch. 

2. Using the stopwatch within a task: 

• You can also use the stopwatch within the task. Open the task and start the time recording by 

clicking on the play symbol of the stopwatch. 

• The stopwatch can be paused and restarted at any time. 

• To record the recorded time, confirm the time recording by clicking on the tick next to the 

stopwatch. 

3. Creation of a classical time tracking entry: 

• You can also create a time entry manually without a stopwatch. To do this, first open the 

relevant task by clicking on it. 

• Then select the option Track time for this task by clicking on the corresponding blue text. 

• A window opens with the newly created time entry, which you can adjust if necessary.  

   

Time tracking of Outlook elements (mails & calendar appointments)  

In the InLoox for Outlook Modern Add-in, switch to the Time tab. 

There you can: 

• A: Track time from mails (New since InLoox 11.18) 

• B: Track time from calendar appointments (since InLoox 11.13)  

   

A: Track time from mails 

1. In the InLoox for Outlook Modern Add-in, switch to the Time tab. 

2. In the side panel, select the project to which you want to track time for an email. 

3 .Then, in Outlook, select the email you want to track time for. 

4. In the side panel under A: Track time from email, click the button with the blue check mark next to 

the selected email to create the time entry. 
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Note By default, the email subject is used for the time entry. Via the three-dot menu, you can 

also include the email body using the slider. There you can also decide whether a category should be 

set for a booked email. 

 

5. The time entry for the email will open, and you can enter the details such as  duration, etc. 

6. Done! The time has been tracked. 

   

B: Track time from calendar appointments 

1. In the InLoox for Outlook Modern Add-in, switch to the Time tab. 

2. In the side panel, select the project to which you want to track time for an email. 

3. Under B: Track time from appointment you can view your Outlook calendar 

appointments, navigate up and down in time with the scroll wheel, open the appointment via 

the details or join directly an online appointments with a meeting link. The prerequisite to see your 

Outlook calendar appointments is that you grant the "Calendar-Read" permission to view your 

calendar. 

4. Create a time entry from an appointment by clicking on the Track button next to the 

appointment. If required, you can adjust the details such as the duration of the appointment in order 

to track the time spent per project precisely. 

5. Done! The time has been booked - the calendar entry is therefore marked as Tracked. 
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Tips: 

Private appointments or appointments that are not to be billed can be ignored. To do this, simply 

click on the Ignore button next to the relevant appointment. 

By clicking on the three-dot menu to the right of the project selection, you can make some general 

settings.  

 

This includes: 

• Show ignored appointments 

• Show private appointments 

• Include appointment body (this allows you to define whether the entire description of the 

appointment should be included in the time tracking entry or not)  
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• Open time entry when tracked 

   

Create new project 
If you want to create a new project, you can do this directly from within a task. To do this, proceed as 

follows: 

1. Either create a new task or open an existing task. 

Note It is important that the task is not yet assigned to an existing project (or that you remove the 

project assignment). 

2. Open this task and navigate to the Project field. Enter the name of the project that you would like 

to create. The system compares the name with the existing database - if the name entered is not 

found, the option Create new project appears. By confirming with Enter, the new project is created 

under the name entered. 

3. To specify further details about the project, please go the the Manage page of the project in InLoox 

Web App. 

Info The original task is automatically transferred to the Kanban board of the newly created project.  

   

Module extension - InLoox Web App interface in Outlook 
With the module extension of the Modern Add-in, you can access since version 11.14 all 

functionalities of the InLoox Web App directly in Outlook.  

How to open the module extension: 

1. Open Outlook. 

2. Click on the bottom icon in the horizontal menu bar on the left, which stands for More apps. Then 

select InLoox. 
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3. The “InLoox” tab opens in Outlook. There you have access to the areas  Workplace, Projects, Tasks, 

Time, People, Workload, Dashboards and Reports. 

 

4. Tip Pin the InLoox module extension in the left sidebar by right-clicking and and clicking on Pin in 

order to open the module extension quickly and conveniently.  
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For detailed instructions of the functionalities, please read the online help for InLoox Web App. 

 

Lists 

Create and edit a to-do list 
You can use the lists to create checklists for your project and thus clearly structure project 

information even in an early phase without tasks and scheduling.  

You can only create lists on a project-specific basis, i.e. within a project. 

   

Create a checklist in a project 

1. Open the project to which you want to add the list. 

2. In the project, click Lists on the Start tab in the ribbon. 

3. On the Edit tab, click New List. 

4. In the dialog box on the right, you can now assign a name for your checklist.  If you want to create a 

personal checklist with your own To Dos, check the box Only visible to me. If you have set the 

checkmark, other team members will not see the list. 

   

Adjust and add columns/fields 

In the Fields section, you can now assemble your list from various field types. The following types of 

fields are available: 

• Text 

• Date 

• Integer 

• Decimal number 

https://www.inloox.com/support/documentation/online-help/inloox-web-app/11-0/all-topics-inloox-11-web-app/
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• Control field 

By clicking New field you can add another field to your list and name it as you wish.  

With the help of the arrows you can change the arrangement of the fields in the list, with a click on 

the cross you can delete a field from the list. 

   

Create links to other project elements 

Click New link in the page panel on the right if you want to link your list with one of the following 

elements from your project: 

• Mindmap Node 

• Tasks 

• Planning elements in the Gantt chart 

• Time tracking items 

• Documents 

• Budgets 

• Budget items 

Click on the corresponding link to navigate directly to the linked element, e.g. to a mind map node to 

which the list belongs. 

   

Add list items to the checklist 

Now fill your list with content by adding list items. To do this, click  New Entry on the Edit tab in the 

ribbon. You can type text directly into the line in the list. 

Example: You can create a classic checklist with the two field types Checkbox and Text.  

Example: You create a date list from the fields Date and Text. 

  

Adjust the view 

On the View tab, you can switch between a map and list view. These views only affect the 

appearance of your list, not the contents. 

   

Switch between different lists 

On the tabs at the bottom left you can see all the lists that have already been created for the project. 

You can navigate from list to list there. You can add as many lists as you like to a project. Clicking the 

right mouse button opens a context menu that allows you to create new lists and edit or delete 

existing lists. 

You can also click Edit List on the Edit tab in the ribbon if you want to make changes to the list you are 

currently on. 
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Create a list template 
InLoox allows you to create templates for checklists that are relevant in different projects.  

To do this, first create a checklist that you want to use multiple times in a project of your choice.  

  

Save template 

Save the list by clicking Save Template on the Templates tab. 

Assign a name for the list and confirm with OK. 

The list is then available in the Templates tab. 

   

Export template 

To export the list as a template, click Export Template under the Templates tab. 

You can save the list for further use in InLoox as an InLoox list file or as a CSV or XML file on your 

computer or file server. 

  

Import template 

To use the list template in another project, open the corresponding project, click  Lists under the 

Home tab, then click the Templates tab. 

Then click the Import Templates button and select the appropriate list template from your computer 

or file server. 

 

Mind Maps 
Visually collect and organize your ideas in mind maps with so called nodes.  

 

Thereby you get an overview over all ideas, concepts and drafts.  

Create a mind map 
When creating a mind map we differentiate between two approaches: 

• Plan-based approach: The main nodes of the mind map correspond with the project 

phases (Top-Down). 

• Task-based approach: The main nodes of the mind map correspond with the tasks of the 

project (Bottom-Up). 
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How to create a task-based mind map 

Visually collect and organize your ideas in mind maps with so called nodes. Thereby you get an 

overview over all ideas, concepts and drafts.  

When you are using the task-based approach, you should ensure that the main nodes of your mind 

map correspond with the tasks of the project. 

  

1. Open an existing project or create a new one. 

2. To create a new mind map click on Mind Maps on the Start tab.  

 

3. The main node is automatically located in the center of a new mind map. By default, it corresponds 

to the name of the project. Simply click the node to rename it. 

4. Create as many nodes as needed. Following the task-based approach, the main nodes correspond 

with the tasks of the project. To create a node, right-click on the node in the middle and click on New 

Node in the context menu. 

 

5. By default a new node is created as a sub-node of the marked node. Name the node and push 

enter. 

6. To create sub-nodes select a node and right-click to open the context menu. Click on New Node in 

the context menu. A sub-node that is directly connected to the selected node appears in the mind 

map. Name the sub-node and push enter.  
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7. To edit a node, right-click on it and enter additional information. 

• Progress: Enter the progress as a percentage. 

 

• Flag: Mark the node with a flag. 

 

Alternatively, you can also use the side panel on the right side. Here, in addition to progress and 

flagging, you can also link documents and resources to the node and enter a detailed description.  

8. Create as many nodes as needed and position them by drag-and-drop. 

9. Format the mind map and edit the background color of a node or add a symbol to it.  

 

10. When you are finished you can create tasks from the mind map. Therefore see the 

chapter: Create tasks from a mind map. 

  

Create another mind map 
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To create another mind map in the same project, right-click and choose New Mindmap, or click on 

the mind map symbol in the lower menu bar, or use the keyboard shortcut Ctrl+M. 

 

 

How to create a plan-based mind map 
Visually collect and organize your ideas in mind maps with so called nodes. Thereby you get an 

overview over all ideas, concepts and drafts.  

When you are using the plan-based approach, you should ensure that the main nodes of your mind 

map correspond with the project phases (Top-Down). 

1. Open an existing project or create a new one. 

2. To create a new mind map click on Mind Maps on the Start tab. 

 

3. The main node is automatically located in the center of a new mind map. By default, it corresponds 

to the name of the project. Simply click the node to rename it. 

4. Create as many nodes as needed. Following the plan-based approach, the main nodes correspond 

with the project phases. To create a node, right-click on the node in the middle and click on New 

Node in the context menu. 

 

5. By default a new node is created as a sub-node of the marked node. Name the node and push 

enter. 

6. To create sub-nodes select a node and right-click to open the context menu. Click on New Node in 

the context menu. A sub-node that is directly connected to the selected node appears in the mind 

map. Name the sub-node and push enter.  
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7. To edit a node, right-click on it and enter additional information. 

• Progress: Enter the progress as a percentage. 

 

• Flag: Mark the node with a flag. 

 

Alternatively, you can also use the side panel on the right side. Here, in addition to progress and 

flagging, you can also link documents and resources to the node and enter a detailed description.  

8. Create as many nodes as needed and position them by drag-and-drop. 

9. Format the mind map and edit the background color of a node or add a symbol to it. For more 

information on formatting see Selected Mind Map features.  
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10. When you are finished you can copy the mind map to the planning. Therefore see the following 

chapter: Copy a mindmap to the planning 

   

Create another mind map 

To create another mind map in the same project, right-click and choose New Mindmap, or click on 

the mind map symbol in the lower menu bar, or use the keyboard shortcut Ctrl+M. 

Selected mind map features 
Open a project and click on Mind Maps on the Start tab to open the Mind Map page. 

InLoox offers you various features for creating and designing mind maps: 

Features on the Edit tab 

 

• Reset Node: Remove a node after drag-and-drop to its initial location. 

• Progress: Express the progress of a selected node as a percentage. 

• Flag: Highlight a selected node with a colored flag. 

• Create Tasks: Create tasks from either All Nodes, End Nodes, or Selected Nodes.  

TIP For more information on how to copy a mind map to the planning see Copy mind map to the 

planning and on how to create tasks in a mind map see Create tasks from a mind map. 

Features on the Format tab 
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The Format tab allows you to customize font, background and frame color of selected nodes.  

Additionally, you can use further helpful features: 

• Apply Format to Child Nodes: Apply the format of a selected main node to its child nodes.  

• Icons: Highlight selected nodes with symbols. 

• From File & Remove: Add or delete a picture to/from a node. 

 

Create tasks from a mind map 
You can create tasks from existing nodes of your mind map.  

This procedure is most suitable when you have created the mind map following the task-based 

approach. This means the main nodes of your mind map correspond with the tasks of the project 

(Bottom-Up). 

For more information on the task-based approach see: How to create a task-based mind map. 

  

Proceed as follows: 

1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 

3. The Mind map is opened now. Click on Create Tasks and choose which nodes you want to 

transform into tasks. 

 

You have the following possibilities: 

• All Nodes: All nodes of the mind map including the main node are transformed into tasks. 

The tasks are automatically transferred to the task area of your project.  

• End Nodes: Only the end nodes of your mind map are transformed into tasks. Those can be 

accessed in the task area of your project later on. 

• Selected Nodes: First choose the nodes in the mind map, you want transform into tasks. 

Afterwards click on Create Tasks and then on Selected Nodes. 

• Include Nodes with Tasks: Select this option to once again create tasks from nodes, which 

have already been transformed.   
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 After you have selected an option, the tasks are automatically created from the nodes.  

4. In the task list/the Kanban board, you can find all the tasks that have been transferred from the 

mind map. They are marked with a mind map symbol. 

 

5. In the mind map all nodes that already have been transformed into tasks are marked with a task 

symbol.  

 

TIP For more information on how to add important information to tasks, see Create and edit tasks. 

 

Copy mind map to the planning 
You can copy the structure of a mind map to the planning. Thereby each node will be transformed 

into an activity in the planning. This procedure is most suitable when you have created the mind map 

following the plan-based approach. Which means that the nodes of your mind map correspond to the 

project phases (Top-Down). 

For more information on the plan-based approach see: How to create a plan-based Mind Map 

  

Proceed as follows: 
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1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 

3. Click on Copy to Planning on the Edit tab. 

 

A new dialog box will open.  

 

• Start: Choose between Automatic calculation and Manual calculation to define the start 

date for the planning. For the manual calculation enter an individual start date. 

• Duration: Additionally, you can define the duration for each activity by using work days, hours 

and minutes. In general, the duration of activities that have been copied from a mind map is 

the same. You can customize the duration of activities in the planning. 

4. Click on OK and the planning will open. Each node of the mind map is displayed as an activity.  

Tip For more information on planning see: Project planning 

 

Export a mind map template 
You can save mind maps as templates to re-use them for other projects. You can save the template on 

your computer as well as to the InLoox templates gallery view. 

   

How to save a mind map template to your computer 
1. Open an existing mind map. 

2. Click on Export Template on the Template tab, to save the mind map on your computer. 

3. Choose one of the following formats in the drop-down-list: 

• InLoox Mind Map File 
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• Vectorgraphics: Use this format in any other file you want and edit it. With copy & paste you 

can easily export the mind map structure as a vectorgraphic. 

Tip To learn how to use the templates later on, see Import a mind map template. 

   

How to save a mind map template to the InLoox templates gallery view 
1. Click on Save Template on the Templates tab. 

2. Name the template in the new dialog box and click on OK. 

3. The saved template can be accessed on the Templates tab in the InLoox templates gallery view. 

 

Import a mind map template 
Mind map templates simplify the creation of mind maps. Templates contain predefined nodes and 

resource data.   

Tip For more information on how to create a mind map template, see Export a mind map template 

 

How to open a mind map template from your computer  

1. Open an existing mind map. 

2. Click on Import Template on the Template tab, to load an existing mind map from your computer. 

In the drop-down-list choose InLoox Mind Map Template and then select the template from your 

computer. 

How to open a template from the InLoox gallery view 

1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 

3. Open the Templates tab and click on a template in the gallery view. 

 

Project list 
The project list provides you with a brief overview of all your projects. It includes various features 

that make project editing easier and faster. As a standard, you can see only those projects in the list 

that are accessible for you. 

Selected project list features 
To get to the project list, click on the InLoox tab, then click on Projects in the Outlook Ribbon.  

 1. Functions in the InLoox Ribbon 

On the Start tab, in the InLoox Ribbon, you can find additional functions that make your work in the 

project list easier. 

Administrators can define the categories as well as the different statuses individually in the InLoox 

settings. 
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2. Open or create a project 

Open project 

Double-click the desired project in the project list. Or right-click on the project to open the context 

menu and select Open project. 

  

Create project 

Right-click the project to open the context menu and select New Project. Alternatively, you can select 

New Project under the Start tab. 

  

3. The context menu and helpful shortcuts 

The context menu offers almost all functions that are also available in the InLoox Ribbon. To open the 

context menu, right-click in the project list. 

For more information on how to structure the project list, see Create a view. 

  

Helpful keyboard shortcuts 

• F5 - refresh the project list. 

• CTRL+P - Print the project list. 

• CTRL+C - Copy a project to the clipboard. 

• CTRL+V - Paste a project from the clipboard to the project list. 

 

Conditional formatting as a warning system 
Define conditions for important project information or key figures so that the respective field or row 

is highlighted (e.g. colored) when the condition occurs. This function is particularly suitable for: 

• Project controlling as an early warning system for critical projects.  

• For optimal structuring of the project list 

  

Add Simple Formatting 
Simple formatting compares the value of a field with a stored reference value (condition). In the 

following example, we want to add a red background to the projects in the project list whose actual 

expenses are above a given value. 

1. We start from the project list. On the Start tab, click Conditional formatting. 

2. The Format Rule Manager opens. Here you can set a new rule for formatting your project list 

on the New Rule button. 

3. Clicking on New Rule opens another window called New Formatting Rule. Here, 

select Format only cells that contain this as the rule type. 
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4. In the rule description, select whether you want to format according to a specific cell value or 

data within a specific range. For our example, we will choose the first option  Cell Value. 

5. In the drop-down menu of the field to the right of it, specify the condition. For our example, 

we choose Greater than. Another field appears in which you can enter the corresponding 

reference value, for our example, 5000. 

6. In the Format area, you define, among other things, with which color the cell/row should be 

filled, e.g. red. 

7. Once you have completely defined your formatting rule, confirm it by clicking OK. 

8. You are now back in the Format Rule Manager. Here you will find checkboxes to apply the 

rule formatting to the entire line and to stop the rule. Here you can also select the category 

to which the rule is to be applied. For our example, select Total Expenses (ACTUAL). 

 

Advanced Formatting 
Advanced formatting allows the mathematical calculation of a value, which can then be compared 

with a reference value. Several fields can serve as variables for such a calculation. In the following 

example, we will check whether the actual expenses of a project exceed the planned expenses. 

1. We start from the project list. On the Start tab, click Conditional Formatting. 

2. The Format Rule Manager opens. Here you can specify a new rule for formatting your project 

list on the New Rule button. 

3. Clicking New Rule opens another window called New Formatting Rule. Here, select Use a 

formula to determine the cells to format as the rule type. 

4. In the editing of the rule description you can create the desired conditions and link them 

using the operators "and", "or", "not and" and "not or".  

5. Add a new condition on +. For our example, first select Sum expenses (ACTUAL). For the 

comparison operator, select greater than. As the comparison object, again select Total 

Expenditures (Planned). By clicking on the icon in the comparison object field you can switch 

between self-defined values and automatically generated values of other categories.  

6. As with the simple formatting, you can now define in the Page panel in the Format area how 

the projects whose actual expenses are greater than the planned ones are to be highlighted. 

Afterwards, confirm your new formatting rule with OK. 

7. You are now back in the Format Rule Manager. Here you will find checkboxes to apply the 

rule formatting to the entire line and to stop the rule. 

8. In the project list, all projects that fulfill the condition are now highlighted.  

 

The tree structure in the project list  
If you have opened the project list, you will find the tree structure on the left side of the screen 

(provided: Outlook folder structure is expanded on the left). This provides you with additional views, 

such as Favorites, Project Requests, Archive and Recycle bin. 
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How to duplicate a project 
In the project list you can duplicate complete projects. This is very useful if you want to create a new 

project that is very similar to an existing project. In this chapter, we will briefly show you how to copy, 

paste and then edit a project. 

1. Click Projects in the InLoox tab to open the project list. 

2. in the project list, select the project you want to copy ...  

Helpful keyboard shortcuts: 

• CTRL+C - copy the selected project. 

• CTRL+V - paste the selected project. 

  

3. To edit the copied project, first assign a new project number. Then adjust the project information, if 

necessary. For more information, see Creating a project. 

 

Print the project list 
You can print the InLoox project views as well as project pages - all print settings and functions are 

located in the Print dialog box. In this window you can make all the desired settings for printing.  

Click Print on the Start tab and the dialog window opens. You will see the print preview and all the 

important functions that you can use. To set the optimal display of the document to be printed, click 

on Scaling and select the desired percentage value from the drop-down menu. With the help of the 

scaling you enlarge or reduce the document in percentage to the current size.  

 

Restore a project 
Recycle Bin 

In the recycle bin you will find all projects that you have previously deleted in the project list.  

To remove a project permanently, click Permanent delete. NOTE You need the appropriate 

permissions for this. The administrator can manage them in the InLoox settings.  

If you have deleted a project by mistake, you can get it back by clicking the button  Restore from 

recycle bin. 

   

Archive 

In the archive you will find all the projects that you have previously archived.  

To restore a project just click the button Restore from archive. 

Print the project list 
You can print the InLoox project views as well as project pages - all print settings and functions are 

located in the Print dialog box. In this window you can make all the desired settings for printing.  

Click Print on the Start tab and the dialog window opens. You will see the print preview and all the 

important functions that you can use. To set the optimal display of the document to be printed, click 
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on Scaling and select the desired percentage value from the drop-down menu. With the help of the 

scaling you enlarge or reduce the document in percentage to the current size.  

Search and filter projects 
Search function 

1. Click on the field with the magnifying glass above the project list. 

2. Enter a search term here. 

3. All projects that contain the text you entered will be displayed.  

4. When you have finished searching, end the search by clicking on the X (close search) next to 

the magnifying glass. 

Quick filters 

With the new Excel-style quick filters, you can now refine your search in table views even more easily. 

Depending on the field type, advanced text and date filters are available. For example, you can filter 

your project or task list by different date ranges: 

Click the funnel icon that appears when you hover over a column heading, then click the Date 

Filters tab 

Favor projects 
To mark a project as Favorite, make a right click on a project and select the entry "Favorite".  

In the project list the project gets a yellow star. 

 

Quick access to projects 
The last used projects can be found on the left side under "Projects".  

Here you will also find the project favorites and also your own projects.  

 

Project planning 
Creating a Project Plan with InLoox 

With InLoox, you create Gantt-Charts for your project planning. Such a Gantt-Chart consists of 

milestones, specific points in a project timeline, and activities, which are scheduled phases in a 

project with a specific start and end date.  Several activities can be combined to form a summary 

activity. Activities usually comprise of one or more tasks that need to be done in order to complete 

the activity. 

This is how you can create a project plan with InLoox: 

1. Adopt planning elements from a project mind map. 

2. Import an InLoox planning template or a Microsoft Project ® planning template.  

3. Copy and paste planning elements from an Excel-file. 

4. Or create the project plan manually, described as follows. 



 52 User Manual  InLoox 11 for Windows/Outlook 
Professionals 

 
ATTENTION You can only create an InLoox project plan if you have the necessary permissions. You 

need to have permissions to Edit Projects and to Edit “Planning”. If you only have permission 

to Access Projects and Access “Planning”, you are unable to create a project plan. Learn more about 

permissions here. 

 

Create, edit, and delete new planning elements – activities and milestones 
The following steps guide you through creating a new project Gantt-Chart with InLoox. 

Create new activities and milestones 

To create activities and milestones, proceed as follows: 

1. Open Outlook and click on the tab InLoox. 

2. Click in the ribbon on the Start tab and click on Projects. Create a new project or select an 

existing project. 

3. Click on the tab Start and in the ribbon on Planning. 

The InLoox project plan consists of the planning list on the left, where you see the two 

fields Info and Name when you first open the InLoox planning, and the Gantt-Chart in the calendar 

view on the right. 

 

Click on the tab Edit. Then click on New Activity or New Milestone to create one of these new 

planning elements. You can also use the short cuts Ctrl+N (or Cmd+N) for a new activity or Ctrl+M (or 

Cmd+M) for a new milestone. 
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The new planning elements are visualized in the Gantt-Chart. Activities are shown as bars and 

milestones are diamond shaped. If you want to create a new milestone: 

1. Click on the tab Edit, and then click on New Milestone or press Ctrl+M (or Cmd+M).  

 

2. You see the New Milestone in the planning list. Give it a new name, e.g. “Kick-off meeting”. 

Press ENTER to save.  

If you want to create a new activity, do the same, only click on New Activity in the ribbon or press 

Ctrl+N. 

ATTENTION: If you do not schedule these newly created planning elements (i.e. you have not set a 

start and/or end date) right away, InLoox will use the creation date of the project for milestones. 

Activities will also start at the creation date of the project and will be given a duration of one day 

(with a default setting of 8 work hours). 

When planning element’s start date lies in the past, they are all highlighted in red and are marked as 

overdue by the symbol in the info column. 
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Create summary activities 
If you combine several activities which are logically connected and need to be finished within the 

same time frame, you create a summary activity. 

Proceed as follows:  

1. Create all those activities, that you want to combine, e.g. all marketing activities.   
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2. Mark each of the activities by pressing Ctrl and clicking on each planning element. In this 

example, “event marketing” is supposed to become the summary activity.  

 

3. Then click in the ribbon on Edit and click on the right arrow in the section Arrange. 

 

The individual activities are now indented.  

4. The summary activity “event marketing“ is visualized in the Gantt-chart as a summary bar. If 

you click on the arrow next to the summary event’s name you can collapse the subordinate 

activities.  
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5. If you want to undo the creation of a summary activity, simply click on the undo icon in the 

upper left hand corner or mark all the subordinate activities of the summary activity and click 

on the left arrow in the ribbon in the section Arrange.  

 

ATTENTION The duration of the summary activity is calculated based on the start and end dates of 

the subordinate activities. I.e. that a summary activity starts on the start date of the earliest 

subordinate activity and ends on the end date of the latest subordinate activity. If you change the 

start and/or end dates of the subordinate activities, the duration of the summary activity is 

automatically adjusted. 

 

 

Change the order of the planning elements 
In order to change the order of the planning elements, proceed as follows: 

1. Click on the planning element that you want to move. 
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2. Open the tab Edit and use the arrows in the section Arrange to move the planning element up or 

down the list.  

 

3. The element Program is now moved up.  

 

Convert planning elements: activity <-> milestone 

If you want to convert an existing activity into a milestone or vice versa, you do not have to delete it 

and create a new one. 

Click on the planning element, you want to convert and then open the tab  Edit and click 

on Convert in the section Action. 

 

ATTENTION Summary activities cannot be converted.  

Link planning elements automatically 

If you have created the planning elements in a chronological order, you can link them with just one 

click and create dependencies between the planning elements. That way, you create a project plan 

based on the waterfall model. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/11-0/all-support-articles-inloox-11-for-outlook-and-inloox-for-windows/project-planning/create-edit-and-delete-new-planning-elements-activities-and-milestones/convert-planning-elements-activity-milestone/
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1. Click on the planning elements you want to link. Use Ctrl+A to mark every planning element in your 

plan. 

2. Open the tab Edit and click on Link Automatically in the ribbon in the section Action.  

 

3. The marked planning elements are now linked. 

 

Proceed to edit the dependencies. 

4. If you want to undo the automatically created dependencies, mark the planning elements whose 

link you want to undo and click on Remove Dependency in the tab Edit in the section Action. 

 

Or click on the undo symbol in the Outlook tool bar in the upper left-hand corner. 

 

Highlight planning elements 

You can highlight planning elements by assigning them a flag or color. Click on the planning element 

you want to highlight, open the tab Edit and click on Flag or Color in the section Highlight. 

 

TIP: In order to see flagged planning elements, display the field Flag InLoox Planning in the planning 

list. 
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Dependencies between planning elements 
When you create dependencies, i.e. establish logical relationships between planning elements, you 

draw up a project schedule. To do that, you need to edit the planning elements and add details such 

as start and end date, duration, the type of dependency and, if necessary, set restrictions. 

You can edit the planning elements in the planning list as well as in the Gantt-chart. 

 

Create dependencies manually 
In order to create dependencies, you have to link the planning elements. Dependencies can be 

established between all planning elements (activities, summary activities, milestones). You can do 

that either automatically, or manually, in your Gantt-chart, described as follows:  

1. Move your mouse over the planning element until it turns into the symbol with arrows.  

2. Now, click on the planning element and move the cursor to the other planning element to link 

them. 

3. Let go of the cursor. The two planning elements are now linked. This way you get linked planning 

elements, which are considered as predecessors or successors of the respective other planning 

element. 

 

Edit dependencies 
To edit an existing dependency, double-click on the link between two planning elements in the Gantt-

chart. The window Edit Dependency opens and you can now change the type of dependency.  

Click on the field Type to select another type of dependency.  

 

Overview: Types of dependencies 

There are four different types of dependencies to link planning elements. 

Finish-to-Start Dependency: 

This type of dependency establishes a relationship between the end of the predecessor and the start 

of the successor.  You ensure that the successor can only start upon completion of the predecessor.  

Example: The activity “event marketing” can only start once the milestone “kick-off meeting“ has 

been successfully completed.   

  

Start-to-Start Dependency: 

This type of dependency restricts the start of the successor, as it can only start once the predecessor 

has started, too. 

Example: The successor activity “partner event program“ starts at the same time as the predecessor 

activity “customer event program“. That means that unless the predecessor has started, the successor 

cannot start.   
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Finish-to-Finish Dependency: 

This type of dependency restricts the end of the successor, as it can only end when, and if, the 

predecessor has been successfully completed. 

Example: The predecessor “customer event program“ has to be completed at the latest on the end 

date of the successor “partner event program“, as the two programs have to be finalized for the 

creation of the event website.  

  

Start-to-Finish Dependency 

This type of dependency is only useful if you create a work-back project plan (work-back schedule). 

When you create a Start-to-Finish Dependency you link the start of the predecessor with the end of 

the successor.  

Example: If a company plans to shut down a server on a certain date and move their data to a new 

datacenter to consolidate the hosting, they need to make sure that the new server is up and running 

before they can shut down the old server. Therefore, the predecessor “full-time operation new 

server” needs to be completed before the successor “shut off old server” can happen.  

 

Set the start date and duration of planning elements 

After having linked planning elements, you can set their start dates and duration. The end date of 

activities and summary activities is determined by when (date and time) they start and how long they 

take (duration). Milestones only have a start date – the date and time they happen. 

1. To edit the planning element, double-click on it or click on it once and click on Edit in the ribbon. 

2. In the side panel on the right you can now select the calendar, set the start date, and set the 

duration of the activity.  

  

ATTENTION InLoox has three default calendars to select from: 24/7 (continuous 

operation), Standard (Monday-Friday, 8 AM-4 PM) and Weekend (Saturday and Sunday, 24h). InLoox 

will automatically use the Standard calendar. If you want to change the calendar settings, you can do 

that in the InLoox settings in the section Working Times. 

3. Select e.g. Start and set the start date by selecting On and choosing the date and time from the 

calendar. This way you establish a so-called constraint and set a time frame for the activity.  

4. Now, set the Duration of the activity by either entering the minutes, hours, or days or by clicking 

on the calendar symbol next to the field Duration and selecting the end date and time of the activity. 

Thereby, InLoox automatically calculates the duration of the activity.  

5. You can display the duration of your planning elements in the planning list. Click on  Select Fields in 

the tab View, select the field Duration from the context menu and drag it into the planning list. 

  

Set the duration in the Gantt-chart 

It is advisable to zoom in and enlarge the view to show the individual days, so that you can work 

comfortably in the Gantt-chart.  
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1. Click on Zoom In or Zoom Out in the tab View to adjust the Gantt-chart to your needs. You can also 

use the short cuts Ctrl + Add (zoom in) or Ctrl + Subtract (zoom out).  

2. Move your cursor over the activity until it turns into. Click on the beginning or end of the activity 

bar and expand or contract it. 

3. If you want to change the starting date/time or end date/time, without changing the duration of 

the activity, you can move the activity bar in the Gantt-chart. Click on the activity bar in the Gantt-

chart and move it right or left to the desired date. 

 

Delete dependencies 

If you want to delete a dependency, you can either: 

1.Click on the undo button in the Outlook tool bar in the upper left-hand corner. 

Or: 

1. Press Ctrl and click on the planning elements that are linked by dependencies, which you want to 

delete. 

2. Then open the tab Edit and click on Remove Dependency in the section Action. Alternatively, use 

the shortcut Ctrl+Alt+D. 

Or: 

1. Move the mouse over the predecessor, click on the planning element and retrace the link with the 

mouse button held down. When you are hovering over the successor, let go of the mouse and the link 

is deleted. 

 

Set constraints 
When you set constraints in a project plan, you essentially set time restrictions. Constraints put 

project phases within a specific time frame and can be set for milestones, activities and summary 

activities. Constraints on planning elements limit the flexibility of the project plan: the project planner 

or project manager cannot move planning elements along the timeline freely but need to plan within 

the timely constraints. 

Before you set constraints, you should have established dependencies between your planning 

elements. 

 

Set constraints on activities and summary activities 

After you have created planning elements and established dependencies automatically or manually, 

follow these steps: 

1. Click on the planning element you want to edit. Now you can edit the planning element in 

the side panel on the right. 

2. In the section Time Frame you have the field Constraint where you can now set the 

restriction for this planning element. 

3. Select the type of constraint you want to set (e.g. Start on a certain date) and select the date 

and time in the calendar. 
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Set constraints on milestones 

In contrast to activities, milestones do not have a duration; nevertheless, you can constrain a 

milestone’s start or end date and/or time. This is done the same way as with activities.   

 

Overview: Types of constraints 

You can set different kinds of constraints on planning activities.  

• Start as soon as possible – If you set this type of constraint, this planning element is set to 

start as soon as its predecessor is finished. This allows for maximum flexibility in your project 

plan. 

• End date is as late as possible – Select As late as possible. This constraint is set when the 

latest possible end date for completion should be calculated from the end date of the whole 

project.  

• Start is on a specific date – If your planning element is supposed to start (activity) or happen 

(milestone) on a specific date, select Start - On. Then choose the date and time for the start 

of the planning activity. The activity will have to be started on this specific date, otherwise, 

you will be alerted to a constraint violation as you will see this symbol in your Gantt-chart.  

• Planning element must not start before a certain date  – If you set this type of constraint, the 

planning element may only start on or after a certain date. Select Start - No earlier than. 

Then select the start date and time from the calendar. The planning element can be delayed 

into the future but may not be moved up earlier along the timeline.   

• Planning element must start no later than on a certain date  – This type of constraint is 

useful if a planning element must start before a certain date. The planning element then 

needs to start on this date at the latest. Select Start - No later than and then choose the date 

and time from the calendar.  

• Planning element must be completed on a specific date  – If a planning element needs to be 

finished on a specific date, select Finish - On. Then select the date and time from the 

calendar. This planning element may not be moved along the timeline and must not end 

earlier or later than on the set date.  

• Planning element must not be completed before a certain date  – If you set this constraint, 

this planning element may be finished on or later than the set date. It must not be completed 

sooner, though. Select Finish - Not earlier than and then select the earliest possible date and 

time from the calendar.  

• Planning element must be completed on a specific date at the latest – With this type of 

constraint, the planning element must be completed as soon as possible but no later than on 

the set date. Its completion must not be delayed at all. Select Finish - No later than, then 

choose the latest possible date and time for the completion from the calendar.   

  

NOTE Constraints on single planning elements influence the whole project plan. It may be that you 

are not able to move planning elements freely along the timeline, due to constraints set on planning 

elements. If this is the case, InLoox alerts you to possible constraint violations with the symbol 

“constraint violation” in the planning list next to those planning elements that are affected.  
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TIPP For better overview, it is advisable to show the field Constraint and/or the field with the 

symbol in the planning list.  

 

Remove constraint 
You can remove constraints by either:  

Clicking on the undo-symbol in the tool bar, if you want to remove the constraint you have just 

created. 

Or: 

By clicking on the planning element the constraint of which you want to remove and then clicking 

on Remove Constraint in the ribbon in the tab Edit. Alternatively, you can also use the short 

cut CTRL+ALT+R.  

 

Add lag to planning elements 
In certain instances, you may want to include some buffer to account for delays or external factors 

that affect your project. In this case, you can add lag in your project plan. Lag times can also serve as 

a kind of time constraint between planning elements. 

1. Double-click on the link that connects two planning elements to open the window  Edit 

Dependency. 

2. Add lag in work days or hours and minutes.  

3. You can also add lead time. Click on Negative when the successor can start before the predecessor 

is completed.  

 

Add tasks to your project plan 
We advise to only add tasks to your project plan once you have completed your project structure 

and established logical dependencies and added time constraints. As soon as you add tasks to your 

planning elements, you can no longer edit the planning element. You would have to remove the tasks 

again. 

You can add tasks to your project plan in two ways: 

1. Drag and drop existing project tasks to your Gantt-chart. 

2. Create project tasks manually in your Gantt-chart. How this works, you will learn in this 

article. 

  

Add new project tasks manually 

Follow the next steps to create new project tasks and add them to project elements in your Gantt-

chart. 

1. Click on the activity or milestone to which you want to assign a task.  

2. In the tab Edit, click on New Task.  
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3. The new task is created and is given the name of the activity or milestone to which it has been 

assigned.  

4. You can rename the task directly in the planning list. Alternatively you can enter all the relevant 

information for the task also in the side panel that opens on the right side. As with the name, the 

task’s start and end date, as well as the effort are the same as the activity or milestone it has been 

assigned to.  

 

Publishing planning elements in other project plans  
With the publication feature, you can use selected planning elements (i.e. activities and milestones) 

in other projects. 

Application examples: 

• There is a global annual department planning. The goal is to adopt activities from the global 

planning into other projects that take place during the year. If a change is made to the activity 

in the global plan this should be incorporated into the other projects. 

• You want to incorporate milestones from a corporate milestone plan into projects of different 

departments. 

TIP If you don’t want to use individual planning elements in other projects, but set dependencies 

between two or more projects, then we recommend to create a project group. 

 

Publish planning elements 

Please follow these steps to publish planning elements from a source project in a target project.  

1. Open the planning of the source project. Mark the activity or milestone in the Gantt plan that 

you want to use in another project. 

2. In the side panel on the right you will find the group Publications. 

3. Under Publications, click on Select project. 

4. A drop-down menu will open. The projects for which you have the reading permission are 

displayed. You can select the desired target project either by double-clicking or by clicking 

once and then clicking Apply. 

5. When the publication was successful, you will find a link to the target project in the side 

panel in the Publications group. If you want to delete the publication click on the recycle bin 

right of the target project. 

  

TIP Display the publications in the planning list. If an element has been published, you can recognize 

this by the displayed icon. This way, team members can see at a glance in the Gantt plan which 

planning elements have been published to other projects. 

NOTE It is only possible to publish activities and milestones. The assigned work packages are only 

visible in the source project. Summary activities cannot be published.  

NOTE If an activity has already been published in another project, which the current user is not 

allowed to access, he or she will only see the remark “Project” in the Publications group. 
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Necessary permissions 

A user needs the following permissions to be able to publish planning elements: 

• In the source project: Read planning 

• In the target project: Read planning & Edit planning 

 

How to use published elements in the target project 
You’ll find planning elements that have just been published in the target project at the end of the 

Gantt plan. Now you can move them manually to the place where you want to use them in the plan 

by using the arrow buttons in the Ribbon on the Edit tab.   

Published elements are marked by a circular symbol in the Gantt plan.  

Published elements can be used just like “normal“ planning elements in the Gantt plan, i.e. you can 

create dependencies between them and the other planning elements. 

Clicking on the published planning element in the target project will open the side panel where you 

will find the notice that the regarding object is a published activity from another project and a link 

that leads you to the source project. 

By clicking onto the link you’ll get directly to the source project (provided that you have reading 

permissions in the source project). Only there you can edit or delete the published element.  

IMPORTANT A published activity can only be edited in the source project and will not be displayed if 

you take a snapshot in the target project. A planning element can only be published from the original 

source project of the activity. Further publications into third projects are not possible. 

TIP Use the filter Current Project to blank published elements from the target project. 

 

Behavior in case of constraint violation 

In the course of project planning it is possible that team members edit a published activity in the 

source project. This might affect the planning of the target project.  

In this case, you will find a notice when you first open the planning after the change has been made.   

The planning can be adjusted automatically. Activities and milestones that depend on the published 

elements will be moved accordingly. The rest of the planning is not affected.  

 

Add columns to the planning list 
Modify the planning list by displaying different fields. By default, the Info and Name fields are 

displayed as columns when you open planning for the first time.  

Displaying fields as columns 

1. When you open a project plan, right-click into the planning list to open the context menu and click 

on Select Fields. 

Or open the tab View and click on Select Fields in the ribbon. 
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2. The window Customization with the available columns opens. Drag the fields from the window 

into the planning list. 

3. Rearrange the columns by dragging the fields to another position.  

4. If you want to remove a column from the planning list, open the context menu first and click 

on Select Fields to open the window Customization again. Then drag the field you want to remove 

from the planning list into the window.  

NOTE InLoox will remember your customized planning list and display the selected columns in the 

same order once you create another project plan.  

 

Overview of fields 
The following overview describes each of the fields that you can show in your planning list:  

• Effort – shows the time that is allocated to the task and the accumulated time for the 

planning element based on the assigned tasks   

• Work duration – available time for the completion of the planning element or task 

• Timeline icon – marks the elements that are pinned to the timeline 

• Duration – shows the duration between start and end date of the planning element in days 

and hours 

• Documents – shows whether documents are linked to the element 

• Constraint icon – shows that there is a constraint between planning elements  

• Constraint – shows the type of constraint between the planning elements, e.g. start-to-finish 

• End – shows the end date of the planning element 

• Done date – shows the date the element was marked as done 

• Progress – shows the stage of completion in percent based on the tasks allocated to the 

planning element 

• Info icon – shows if an element is done, overdue, locked, or violates a constraint 

• Calendar – shows which calendar is used for this Gantt-chart 

• Flagged icon – shows which elements are marked with a flag 

• Critical – marks the planning elements along the critical chain as true or false 

• Successor – shows the succeeding planning element if a dependency exists 

• Location – free text field for you to enter the location the planning element takes place at 

• WBS Code (calculated) – shows the automatically calculated work breakdown structure code 

• WBS Code (manual) – free text field for your own work breakdown structure code 

• Resources – shows the name of the assigned resource 

• Start – shows the start date of the planning element     
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• Published icon – marks those elements that are used in other project plans 

• Predecessor – shows the preceding planning element if a dependency exists 

Note  To ensure consistent presentation and labeling between InLoox Web App and InLoox for 

Windows/Outlook, we have adjusted and harmonized some labels for InLoox 11.4.2. The differences: 

• Effort = Effort of the task or Summarized effort of the tasks subordinate to an activity  

• Duration (former Work duration) = planned duration of the activity in workdays 

• Timespan (former duration) = Effective duration incl. non-working time, calculated on the 

basis of the defined working time calendar 

Until InLoox 11.4.1 

 

 

Since InLoox 11.4.2 
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Create your own fields 

You can also define your own fields for the planning list. To be able to create your own fields, you 

need administrator rights. You can learn more about this under the settings. 

 

Critical path, slack, and time line 
Especially when you have a complex project plan, details like the critical path or lag time between 

dependent planning elements can increase transparency and help you retain a good overview.  

Show critical path in Gantt chart 

The critical path marks those planning elements that are crucial in keeping your deadline. Delays 

along the critical path can lead to scope creeps and possibly derail your scheduled project deadline.  

If you want to show the critical path in your plan, you must already have planning elements that are 

connected with each other. 

1. Open the project and the Gantt-chart. 

2. Click on the tab View. 

3. Click on Show Critical Path. 

The planning elements along the critical path are marked in red in your Gantt-chart and in your 

planning list. 

Show slack 

InLoox shows you how far you can move a planning element before this affects the planned duration 

of the project and, for example, shifts the completion date. 

To do this, follow the steps: 

1. Go to the tab View. 

2. Under the group Details, click on Show Slack. 

3. Select a planning element. The time distance in days is then displayed directly in the 

planning. 

 

Show timeline in project plan 
In each project planning, you can visually highlight individual planning elements that you want to 

have a closer look at in a timeline. 

1. Open the project planning and first display the field with the pin in the planning list.  

2. Under View, click on Show Timeline. An empty timeline now opens under the ribbon. 

3. Select the planning elements that are to be visualized in the timeline by clicking on the icon 

with the pin in the respective line. Alternatively, you can select the planning elements and 

then go to the Edit tab and under Action click on Add to Timeline. 

4. The planning elements added to the timeline are now marked in the planning bar.  

5. You can use the sliders to enlarge or reduce the section displayed in the timeline, as well as to 

drag the timeline itself up or down. 
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6. If you want to remove planning elements from the timeline again, click on the pin symbol in 

the planning bar again and the respective element will be removed from the timeline.  

7. You can also copy the timeline to the clipboard and send it by e-mail, for example, or save it 

as an image. To do this, right-click in the timeline and then click Copy to clipboard. 

Show workload in project plan  
Starting from the project planning, you can access the workload overview of resources and view the 

workload of the project team on a project-specific basis. 

1. On the tab View, click Workload on the far right under Dialog to open the resource overview 

window. 

2. Select Only this project as the filter option in the ribbon. 

3. Now drag the resources whose workload you want to view either from  Divisions and 

Teams on the right to the field Name on the left or create a New Team on the bottom right 

and drag it to the left. 

4. Click on the arrow in front of the team to expand the individual resources and see their 

workload in the calendar. 

5. Under the calendar view, you can see the workload of the selected resource in a bar chart.  

Loading, importing and exporting planning templates 

Working with planning templates is a convenient way to create project plans quickly and easily. 

InLoox administrators can also edit planning templates in the InLoox settings.  

Load project planning from InLoox template 

If InLoox plannings have already been saved as templates on your database, you can use them for a 

new project. 

1. To do this, create a new project and then click Templates under Planning. 

2. Select an InLoox template. 

3. In the Load template window, define the time frame for the planning. Select Automatic 

Calculation if you want the start date to be the same as the creation date. 

IMPORTANT: If planning elements with restrictions have been saved in the template, InLoox will 

adopt these settings when importing the template. Thus, start and end restrictions that may be in the 

past will be applied and all planning elements will have to be adjusted manually. 

If you want to set the start date manually, select Manual Calculation and choose a date from the 

calendar. 

IMPORTANT: If planning elements with restrictions have been saved in the template, then InLoox will 

NOT take over these settings when importing the template. Start and end restrictions are not applied 

and all planning elements with the restriction Start = As early as possible are imported. This facilitates 

the further processing of the planning and is the recommended procedure by InLoox.  

4. We recommend that you accept the preselection for both Load resource data and Remove 

completion data. 
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• Load resource data - The resource assigned to the task and the estimated effort, if any, are 

taken from the InLoox template. If you do not check the box, these fields will remain empty in 

the tasks. 

• Remove completion data - The Completed marker will not be transferred. No planning 

element will be marked as completed in the new planning. 

Import templates and save them as InLoox template 

To make planning templates available to all InLoox users working on your database, you can import 

files and then save them as InLoox planning templates. In addition to InLoox planning files, you can 

also import Microsoft Project ® files. 

Import Microsoft Project ® template 

You can import a planning template created with Microsoft Project ® into InLoox.  

1. To do so, click Import Templates in the ribbon and select the Microsoft Project file format you 

want to import. 

2. Select the file from your server and click Open. The planning will now be displayed in the 

Gantt chart. 

3. To save this planning as an InLoox template, click Save Template in the ribbon and give the 

template a name. Confirm with OK. 

All InLoox users working on your database can now access this template.  

Import InLoox template 

An InLoox planning file ends with *.inlooxplanning. To import such a file, follow the same steps as 

described above. 

Export templates 

When you export a planning as a template, you save it to your server or local storage.  

1. Click Export Template in the ribbon. InLoox offers you three different file formats for the export: 

• InLoox planning file 

• Microsoft Project XML file 

• Image in *.png., *.jpg, or *.bmp format 

2. Select the format, choose the location and confirm with Save. 

TIP If you want to save the planning as an image, first adjust the planning view according to your 

needs. InLoox maps the current section of the planning that you see in the active Gantt chart itself.  

Copy data from an Excel spreadsheet 

If you have made a planning in an Excel spreadsheet, you can transfer it to an InLoox planning by 

using Copy/Paste. 

1. Open the Excel spreadsheet and select the data that corresponds to the planning elements 

(activities and milestones) in your Excel spreadsheet. 



 71 User Manual  InLoox 11 for Windows/Outlook 
Professionals 

 

 

NOTE Please note that when you copy multiple cells in a column, Excel also copies the cells in 

between. In this case, we recommend selecting each cell individually, copying it and pasting it into 

the InLoox planning. 

2. Click on Copy. 

3. Open the InLoox project and the planning where you want to copy the Excel elements.  

4. Now click Paste in the InLoox Planning ribbon under Edit. 

5. The elements copied from the Excel spreadsheet to the InLoox planning are displayed as activities 

with a start date according to the project start. 
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Now you can edit the planning elements as usual. 

Snapshot Feature 
The snapshot function in InLoox Planning allows you to record the current status of your project 

Gantt-chart. You can use the snapshot as a reference to visually track the changes to the Gantt.  

Creating a planning snapshot 

1. Open the project, go to the Planning of the project. 

2. In the Edit tab, click on Snapshot in the menu under Action. The snapshot bar appears below the 

Gantt-chart. 

 

3. Click into the New Snapshot field on the right, enter a name, e.g. "As-is-01-11-2024" and click on 

the camera icon. The snapshot is created. 

4. When you hover over the snapshot with the mouse, a window opens.  

You can now: 

• Show (Overlay) this snapshot in the Gantt chart. 

• Delete this snapshot. InLoox asks you whether you really want to delete the snapshot.  

5. By clicking on a snapshot, this status is also displayed and you can see the changes in the planning 

that have been made since the snapshot in the Gantt chart. This does not overwrite the current 

planning. 

6. If you want to hide the displayed status again, click on Current state at the bottom of the snapshot 

bar. 

7. lf you want to hide the snapshot bar again, click on Snapshot in the menu again. 
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Change planning direction 

When you create a new project, InLoox defaults the planning direction to forward scheduling from 

the project creation date. If you want to change this, you can do so in the Settings tab and either 

select a different planning start for forward scheduling or change the planning direction to backwards 

scheduling. 

Changing the planning start of forward scheduling  

1. After you have created a new project, click on Planning and there, on the Settings tab, 

on Direction. 

2. Click on the date and enter the new planning start manually or select a new start date from the 

calendar and set an exact time if necessary. 

3. Now click on the Edit tab and create your project planning. The planning elements you now create 

will start on the start date you set. 

Backwards scheduling 

1. After you have created a new project, click on Planning and there on the Settings tab on Direction. 

2. First click on Backwards scheduling to set a check mark. 

3. Click Direction again and now select the planning end by either entering it manually or selecting it 

from the calendar. 

 

Fixed Deadline 
The 'Fixed Deadline' feature provides you with an additional option for visualizing delays that could 

have a negative effect on the finish date of your project. This feature is useful if the end date of your 

project marks a fixed deadline. Delayed milestones or activities that lie outside of the planning period 

are highlighted in an orange shaded field in the project plan. 

1. Start from the project overview: Double click to open an already existing project or, to create a new 

project, click in the ribbon on the Start tab and on New Project. 

2. Activate the Fixed Deadline in the management view on the Edit tab. 

The feature highlights all activities that are delayed beyond the project end date (specified on the 

management page) in an orange shaded field in the planning. See at a glance whether the project can 

be completed on time or whether delays have negative effects on the deadline.  

3. You can activate or deactivate the feature at any time in the management view of your project.  

 

Print planning 

1. How to open the print preview 
Open a project >> Go to Planning >> Click on the View tab >> Click on Print 
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2. Overview of the print preview ribbon 
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3. Print preview features in detail  

(1) Print 

Edit the printer settings before printing. E.g., determine which pages you want to print or whether 

you want to print in landscape or portrait mode. 

(2) Print immediately 

Click on Print immediately to print your planning using the default printer settings.  

(3) Time frame 

If you only want to print the planning for a specific time frame, you can define it here. E.g., only print 

the planning elements for the next week for your weekly meeting – so you can keep track of the tasks 

and activities that have to be done during that week. 

 

(4) Table settings 

• You can set a specific width for your table by choosing 1-5 with 1 being the default setting. 

The bigger the width of your table, the more detailed will your print be and, of course, longer.  

• You can also customize your table via the table scaling. E.g., if you want to see the complete 

project plan on one page but your planning is so long that it doesn’t fit into one page.  

• You can also display the planning list (fields) on all pages – this allows you to quickly match a 

bar in the Gantt chart with its activity. 

(5) Timeline interval 

Determine whether you want the planning to be displayed in weeks, months or years. 

(6) Display more columns (fields) 

You can also display more columns, i.e. fields. The changes you make in the print preview won’t 

affect the view of your original project plan. 
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(7) Select printer 

Select a default printer – this setting will apply to all projects 

(8) Paper size 

Print your project plan in various sizes. 

(9) Page margins 

Customize the page margins of your print. Note: There’s a minimum margin of 4,32cm  

(10) Scaling 

Enlarge or reduce your planning view – without changing the printing range. 

(11) Navigation 

Quickly jump to the right page via the navigation. 

(12) Zoom 

Enlarge or reduce the print preview – this won’t affect the actual print, it’s merely an optical zoom.  

(13) Watermark 

Protect your print documents with a watermark. You can use a text or picture: 

• If you select “Text Watermark” then you can choose between a variety of preset texts or 

enter your own text. 

 

• You can also use an image as a watermark, e.g. your company’s logo. Just click on the tab 

“Picture Watermark“ and upload an image. 

TIP   We recommend using a .JPG file. 
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Select the position “In front“ and increase the transparency (e.g. 200) so that the watermark will be 

shown in the front but won’t be too overwhelming.  

(14) Export & Send as email 

You can export the print of your project plan or send it directly via email.  

• Export to PDF 

Click on the button “Export to” to export your print to PDF. Alternatively click on the arrow to 

open the dropdown menu and select “PDF file”. Then you’ll be able to define the PDF 

settings. E.g. protect your file with a password or add a digital signature. 

• Export to Image file 

Click on the arrow to open the dropdown menu and select “Image file” to export your print. 

You can save all pages of your project plan in one file or save each print page in an individual 

file. 

• Send as email 

You can also send your print via email. Click on the button „Email as”, to send the file as a 

PDF. Or click on the arrow to open the dropdown menu and select “Image file” to send the 

print as an image file. You can customize the PDF and image settings as described above. 

Before you can send the file via email, you’ll have to save it locally first. After you have 

selected a storage location, a new email window opens with the print file attached.  
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Project-related tasks 
Warning As of version 9, work packages have been renamed tasks.  

Project-related tasks are tasks that belong to a specific project. In InLoox, you can use the Kanban 

method to manage these tasks. 

In project management, Kanban is a method to visualize tasks and to manage the flow of work. Tasks 

are divided into three categories that are displayed on a three-column board: To Do, In Progress, 

Done. The status of tasks and competences are always clear. In the classic Kanban method, tasks are 

not scheduled, but in InLoox you have the option to create tasks with and without a deadline.   

Create, edit and delete project tasks 
There are several ways to create project tasks in InLoox: 

• Copy tasks from a project mind map 

• Import tasks from a template 

• Create tasks manually 

You can also combine all three methods. In this chapter we look on the topic of manual task creation. 

Creating tasks manually 

1. You are in the project for which you want to create a new task.  

2. Click on Tasks in the ribbon on the Start tab. 

3. Now click New on the Edit tab in the ribbon. 

Alternatively, you can also click on the plus in the respective column, then the new task will be 

assigned directly to this column. 
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 A new task appears in the left column of your Kanban board. At the same time, the page panel for 

editing tasks opens on the right. 

• Name and description: Now assign a name to your task and describe it. 

• Effort: Enter the estimated effort for the task. By clicking on the small black arrow you can 

change the unit from hours to working days (equivalent to 8 hours by default) or minutes.  

• Resource: You can assign the project task to a resource, but you do not have to. In classic 

Kanban, team members "pull" tasks themselves from the Not Started column. For a quick 

selection of frequently used resources, click on the small arrow; for the global address list, 

click on the three dots to the right of Resources. Now select the person who will be 

responsible for the task. Only one resource can be assigned to each task. 

• Start/End: You can give your task a time frame, but you do not have to. If you want to specify 

a start and/or end time, click the arrow next to Start or End and select Date and Time. If you 

assign a task to an activity in the project schedule, its start and end are automatically taken 

over. However, you can change this again manually. Note: We recommend scheduling a task 

only within the time frame of the activity to which it belongs.  

• Documents: If certain documents belong to the task, you can link them to the task by 

clicking New link in the Documents area. You will then get an overview of all project 

documents that have already been created in InLoox and for which you have read permission. 

If there are no documents in your project library yet, you can upload a new document and 

link it directly to the task by clicking New, selecting a document from your computer and 

confirming with OK. Tip If you want to link a document to a project item, but you have a lot 

of project documents, you can search for the respective document in the document list. To do 

this, simply click on the column above the respective column heading in the entry dialog and 

type in the search term. 

• Budget: You can assign the task to a specific budget group. For each budget group, an internal 

price per hour is stored in InLoox PM. This will be applied to the task by the assignment. 

Budget groups can be set by the InLoox administrator in the InLoox options. By default, the 

Billable checkbox is activated. This means that for the time spent on the task, a plan output 

for the resource costs is created in the project budgets. You can then create an actual 

revenue from this in the budgets. If you uncheck the box, this will no longer be possible. 

• Notifications: The added resources will automatically receive a notification about the task. In 

the Notifications area, you can inform other people, e.g. the project management or a 

substitute, about the new task and any changes to it. To do so, click on the small arrow for a 

resource quick selection or on the three dots to go to the global address book. How and 

when a resource is notified is defined by the InLoox Administrator in the InLoox Options.  

Finally, click Save on the File tab in the upper left corner if you want to save the task but still continue 

working in the project or Save and Close if you want to save the task and close the project. 

   

 

Editing tasks 
You can edit an existing task by clicking on it and then clicking Edit on the Edit tab in the ribbon. The 

page panel that you already know from creating a new task will open. You can now make the desired 

changes to the task. 
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You can also quickly edit certain information of a task inline, such as the task name, start date, effort 

or resource. 

If a task is done, you can select it and click Done on the Start tab in the ribbon. The same command 

can be found in the context menu. To do it, right-click the task and select Done. 

When a resource marks a task as done, all people registered on the task under Notifications will 

receive a notice about it. The task is automatically moved to the Completed column or to the right 

outer column of the Kanban board. The completion is also reported back to the project schedule and 

is included in the project progress calculation. If a project manager marks the task as done, then the 

responsible resource and all the people entered under Notifications will receive a notification.  

Tip If there are many similar tasks in your project, you can copy the tasks. To do this, click on the task 

with the mouse, click Copy on the Edit tab in the ribbon, and then click Paste. 

Attention If the copied task contains constraints from a task in the planning in the original version, 

these constraints will not be taken over when copying. However, manually set start and end dates will 

be applied. 

 

Deleting tasks 

You can delete tasks by clicking on the corresponding task in the list and then clicking  Delete on 

the Start tab in the ribbon. This function is also available in the context menu, which you can reach by 

right-clicking on the task you want to delete. 

When you delete a task, the people for whom you have set up notifications will be informed about it. 

If you, as a project manager, delete a task for which another resource is responsible, then that 

resource will be notified about it. 

Note The deleted tasks are irrevocably removed, you cannot restore them.  

Tip If you want to delete several tasks at once, you can do it with Multiselect. To do this, hold down 

the CTRL key on your keyboard and left-click on the tasks you want to delete. Now select Delete in the 

ribbon. 

 

Team task management with Kanban 

This is how a Kanban board is structured 

A Kanban board is read from left to right: On the far left are always the unfinished tasks or the 

backlog. On the right side there are always the completed tasks. 

In each status column the hours of all tasks which are in the column are added up. This is handy if, for 

example, you only have a certain quota of hours for the project. You can quickly see the estimated 

effort of all tasks in the project without having to go to the dashboard for it. As soon as you move a 

task to another column, the number of hours in the respective status column adjusts automatically.  

 

Change and delete status 

You can customize the number and naming of the columns to suit the way you work. To do this, 

click Edit Status on the Edit tab. A page panel opens on the right: 
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Click New Status to add another column to the view. You can give the new column a name and assign 

it a color. Your Kanban board would now have four columns.  

You can also edit one of the existing states. In the side panel, click on the state you want to change 

and in the dialog box, change the name and the color assigned. The color helps you to identify tasks 

with the same state at a glance. 

You can use the arrows to control the order of the Kanban columns - the top entry in the list is the 

leftmost column, the bottom entry is the rightmost column. You can delete columns using the cross.  

New tasks always appear first in the leftmost column. You can drag them to another column to 

change their status and color assignment. For example, when a team member starts working on a 

task, they can drag it from the Not Started column to the In Progress column. This way all team 

members can see who is currently working on what. Once you drag the task to the far right column, it 

is considered complete. 

You can recognize overdue tasks by the red marking of the start and/or end time. For example, the 

following task should have already been started, but is in the Not Started column.   

Attention: No matter how you name and arrange the columns - in InLoox, the tasks in the leftmost 

column are always listed as Uncompleted and the tasks in the rightmost column are always listed as 

Completed. 

Note: Adjustments to the Kanban board are always visible for the entire project. If you want to define 

a Kanban structure for all projects in the database, the InLoox administrator has to define this in the 

InLoox settings. 

 

Meaning of the icons on the Kanban cards 
You can see directly on the task card if the task was created from a mindmap node and if it was added 

to a planning process. Click on the respective icon to go directly to the corresponding mind map or 

planning process. You can also see from the icons how many lists, documents and notes a task has. 

Customize the task view 

Sort 

You can arrange the tasks on the Kanban board according to different criteria. To do this, click  Sort on 

the Edit tab in the ribbon and select by which criterion you want to arrange the tasks:  

For example, if you arrange by workload, you will see which task takes the least amount of time. Only 

you can see this arrangement locally on your computer. 

 

Color 

You can also assign an individual color to each task, which overrides the color of the current task 

status. This way you can highlight and mark tasks individually. Again, this highlighting only applies to 

the individual user, other InLoox users will not see this. 

Click on the task you want to highlight in color. Then click Color on the Edit tab in the ribbon and 

select the color you want. 
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Show details 

To view the details of the task in question, open it. Either click on the corresponding task card and 

select Edit under the Edit tab or double-click on the corresponding task card. Then a corresponding 

menu will open on the right side. Here you can view all the stored information and edit the task itself. 

You can also see the comments of other project participants and the project status. 

Filter 

Using the full text filter you can additionally select tasks. For example, filter by a resource name to 

see only the tasks of the respective person in the project or filter by a specific keyword. Use the 

search field provided for this purpose, which is located above the Kanban board, and confirm your 

search by clicking on Find. 

Assign tasks to resources 
To assign a task to a specific person, click the person icon on the task card.Here, select the 

appropriate resource from the drop-down list or open the global address book by clicking Address 

Book.  

Alternatively, you can click Select resource in the navigation bar at the top. The address book will 

then open. 

If you want to assign the task to another person, you can simply click the image or the resource 

name again and select the new resource from the list. If you want to remove a resource, 

click Remove resource at the very bottom of the resource list. 

Tip You can also filter by specific skills in the global address book, for example, if the task can only be 

done if the resource has English skills. To learn how to assign specific skills to resources, see the Skills 

chapter. 

Note Divisions and teams in Kanban are no longer available in InLoox 11.  

 

Task templates 
If a certain set of tasks comes up again and again in your projects, it makes sense to save them as a 

task template. For example, these can be tasks that typically arise during a trade show appearance or 

a product launch. This way you don't have to create these tasks over and over again, but only make 

adjustments for your current project. 

Saving and loading a task template 

1. First, create the tasks you want to use in your template in a project. You can learn how to do 

this under Create project tasks. 

2. To save the task template directly in InLoox in the Gallery view, click Save template on 

the Templates tab in the Tasks section of the ribbon in the project. Assign a name for your 

template and confirm with OK. 

3. The task template is now available in all your InLoox projects in the Gallery view in the 

Ribbon. You can find the gallery view in the project in the Tasks section on the far left of the 

ribbon on the Templates tab. 

4. To load a task template from the gallery view into your project, simply click the desired 

template in the gallery. If there are no tasks in your project yet, the tasks from the template 

will now appear in the Kanban view, where you can continue editing them. If your project 

already contains tasks, the tasks from the template will be added to it.  
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5. The InLoox administrator can rename, delete, export and import the task templates from the 

gallery view in the InLoox settings. In addition, ready-made templates are available on the 

InLoox website in the Download section, which you can import into your projects. 

 

Exporting and importing task templates 

If you want to save a task template on your computer instead of in InLoox, you can export it. This is 

useful, for example, to import it into Microsoft Project or to use it in another InLoox database.  

1. In the corresponding project, create the set of tasks that you want to save as a template and 

reuse. 

2. In the Tasks section, on the Templates tab, click Export template in the ribbon. You can now 

choose whether you want to export the file as MS Project XML file (useful for reuse in 

Microsoft Project) or as InLoox task template (useful for reuse in InLoox). Select a variant. 

3. You can now select the desired location on your computer or file server and name and save 

the template accordingly. 

4. To import a task template, click Import Templates on the Templates tab in the ribbon in 

the Tasks section of the project. Again, you can import both Microsoft Project files and InLoox 

task template files. Select the desired file format and choose the appropriate template from 

your computer or file server. 

5. If there are already tasks in your project, the tasks from the template will be added to it.  

 

Add tasks to the project time planning (Gantt) 
If your project also includes a project time planning (Gantt chart), then you can assign project-related 

tasks to the appropriate activity in the Gantt chart. This is particularly useful if a task is to be 

completed within the time frame of this activity and it is related to the content. However, you do not 

necessarily have to assign tasks, they can also exist as "free tasks" in the project.  

To assign a task to the project schedule, please proceed as follows: 

1. Go to planning in the project. To do this, open the project and click on  Planning on 

the Start tab in the ribbon. 

2. Now double-click on the task or collective task to which a task is to be assigned. The page 

panel for editing planning elements opens on the right. 

3. Select the Unassigned tasks tab at the top of the page panel. 

4. You will now get an overview of all tasks in the project that have not yet been assigned to a 

planning element in the Gantt chart. 

5. Now drag the desired task with the mouse from the side panel to the appropriate activity or 

milestone. 

6. You have the following options: 

• Drag the task onto an activity or milestone so that the corresponding row is highlighted. Then 

release the task. It will now be displayed as a task under this activity. A new task is created in 

the project plan. 
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• You can also convert a task into a planning activity. To do this, drag the task from the side 

panel to the position in the planning list where the new task is to be created. A black line 

appears in the planning list. Then release the task. A new task is created to which the task is 

assigned. 

• You can also drag the task from the side panel to a collective operation. A subordinate task 

with the name of the task is then created below the collective task. The task is assigned to 

this task. 

If you want to remove a task from the Gantt chart again, select the task in the planning list. Then 

click Remove on the Edit tab. 

The task will then reappear in the Tasks page panel. 

  

Adding multiple tasks to the project schedule  

You can add single or multiple tasks at once to the project schedule by dragging and 

dropping. You can select multiple tasks by holding down the Shift or CTRL key. Then you 

simply drag the tasks to the project schedule. 

Create comments 

To provide additional information, you can use the comment function. The comment function is 

available in two different locations: 

• On the Manage page, you can enter general comments about the project itself. 

• In the task you can add comments that are directly related to the task. 

Adding comments to a task 

To add comments such as status updates to a task, double-click on the task within the Gantt chart or 

Kanban board so that the editing panel opens on the right. 

Click on the Comments tab and enter the desired text. 

Customize the font, color, size, etc., of your comment. All formatting commands can be found on 

the Format tab. 

• Hyperlink: Create a link to a file, web page or image. Select the relevant part of the note and 

click the Hyperlink button. In the new dialog box, select the desired file in the Address area 

and click Open and Ok. 

• Icon: Select a symbol that is not on the keyboard or is a special character.  

• Image: Go to the folder where the desired image is stored, select the image and click Open. 

Adjust the size of the image. 

Tip Mention your project members directly in the comment by typing the @ sign and then selecting 

the desired resource from the drop-down list. Alternatively, you can enter the resource in 

the Notify field. 

To submit the comment, click Post Comment. The comment is then displayed in the field below. 
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Resources and Allocation 
Resources can be people, but also objects such as rooms, machines or financial assets. It is important 

to have the right resource working on a task or project for its efficient and successful completion. 

InLoox enables you to manage the capacities of staff, rooms or machines, as well as allocate tasks 

according to the resources’ capacities. The result is a more effective use of resources, which leads to 

an increase of your projects’ efficiency.  

Open the resources and workload allocation overview  
Open system wide resources and allocation overview 

Follow these steps to open the system wide, project-independent resources and allocation overview: 

1. Open Outlook and click on the tab InLoox. 

2. Click on Projects in the navigation bar to get the project overview. 

3. Alternatively, you can access the project overview via the tree structure InLoox >> Projects >> 

Projects. 

4. Now select Resource Overview in the ribbon under View. The resource overview opens. 

  

Open resources and allocation overview inside a project 

You can also find the resources and allocation overview inside individual projects. There you can 

display and manage the workload of the project team. 

You can display the workload overview in the Kanban view as well as in the planning. 

Open workload in the Kanban view: 

1. Navigate to your projects InLoox >> Projects and open a project from the project list. 

2. Click on Tasks in the Start tab of the InLoox project window. This opens the Kanban view.  

3. To open the workload overview of your project team, go to the View tab and click 

on Workload. The workload overview opens in a new window.  

Open workload in the Planning:  

Tip You can change the color scheme of the workload view in the planning in the InLoox Settings.  

1. Go to your projects InLoox >> Projects and open a project in your project list. 

2. Click on Planning in the Start tab of the InLoox window. 

3. Under the tab View, click on Workload in the ribbon to open your workload overview. 

4. You can display the workload in all projects (All Projects) or only the workload of the project 

that is currently open (Only this Project).  

5. To display the workload, drag-and-drop one or more divisions and teams into the resource 

overview. If you want to hide the workload of a specific group, just drag-and-drop the group 

back into the side panel.  
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You can also see the capacity of resources next to each task in the planning, provided you have 

allocated a resource to the task. This enables you to see who in the project team still has capacities 

and who is over-allocated. In the latter cases, it is advisable to re-assign tasks to relieve a resource.  

Tip Project teams should never work to capacity (100%), because in most cases they do not work 

exclusively on the project. Usually, they also have to handle their daily workload. This means that 

when they are working to capacity in a project, they are actually over-allocated because you have to 

add 20% or 40% workload for daily tasks to the 100% project workload.  

 

Selected allocation features 
• Add Resource – Add a new resource, e.g. from the global address book or the InLoox address 

book. 

• All Projects – Allows you to view the workload of all projects. 

• Only this Project – Allows you to see only the workload of the currently open project.  

• Re-Assign Task – If you see that a resource is over-allocated, you can relieve them by re-

assigning the task to someone in the team who still has free capacities.  

• Exchange Calendar – this feature is currently not yet available and will be provided in a future 

iteration. 

• Date Range, Zoom In and Zoom Out – Decide for which time range you want to see the 

workload (hours, days, weeks, months, quarters, years). The view of the resources and 

workload chart changes depending on the date range. 

• Print Overview and Workload – Print the current view of the resources overview or the 

workload chart.  

• Refresh – Click on refresh to apply all changes and to update the view.  

• Expand all / Collapse all – Here you have the possibility to show or hide the divisions and 

teams in their entirety, so that either all individual divisions/teams with their respective 

resources are displayed, or only the highest superordinate division.  

• Show Labels – You can decide whether you want to show or hide the percentage of the 

workload next to the bars in the overview. 

• Completed Items – You can show or hide tasks that have been marked as “Done”. By showing 

the completed tasks you will get an overview of the complete workload. If you just want to 

see the current and future workload, then hide the completed items.  

• Divisions and Teams – You can show or hide the Divisions and Teams side panel. The side 

panel displays all departments in your organizations and the resources who work in the 

individual departments. You can also create individual cross-department project teams. 

Please note It is not possible to create new departments (Divisions) in the workload overview. You 

can create, edit and delete departments in the InLoox settings, if you have the necessary 

administrator rights. You can also allocate resources to departments.   
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Show the workload in the resource overview 
Please note The workload overview only shows the workload and allocation of tasks that have a start 

and end date. 

The resource overview shows you a visual overview of the workload allocation during the specified 

date range. You can decide which resource’s workloads you want to see in the resources and 

workload allocation overview. Your own, project-independent tasks are also displayed in the 

workload overview.   

Follow these steps to show the workload in the resources and workload overview:  

1. Open the workload overview as described in the chapter Open the resources and workload 

allocation overview. 

2. Select a group from the Divisions and Teams side panel for which you want to show the 

allocation. To do so, drag-and-drop the group into the list on the left. For example, drag the 

group Your Company into the list to show the workload allocation of your entire company.    

3. If you want to see how the workload is divided between the departments within your 

company, you can open the subordinate groups by expanding the group  My Company. To do 

so just click on the arrow next to the group you want to expand, or expand the group by 

clicking on the ribbon Expand All.  

 

Work with the resource overview 
The resources overview chart shows you the workload of your resources and whether they still have 

capacities or are over-allocated. It is possible to show or hide the workload all or selected 

departments. This enables you to get an overview of the workload of your whole organization, or just 

the workload of one or more departments or project teams.   

The bars show the extent and duration of the allocation: 

• Blue bar: 1% - 100% 

• Pink bar: 101% - 149% 

• Red bar: > 149% 

A blue vertical line marks the current date. 

If you hover over a bar, you can see the details of the allocation:  

• The percentage shows you the extent of the allocation. Over 100% means that your resource 

is over-allocated. 

• The start and end date and the duration of the allocation  

 

Add a new team 
Please note The teams you create in the resources and allocation overview are only visible to 

yourself. Other InLoox users in your system cannot see the changes. So editing or deleting a team 

member has no effect on the resources and workload view of other InLoox users. 

You can create individual teams to see the workload of cross-department project teams. 
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1. Under the Divisions and Teams side panel on the right, click on New Team. 

2. Click on the Edit button and enter the name of the team. 

3. Add team members by clicking on the Add Resource icon (icon with the person and the plus). 

Tip If a team member works on several projects, then you can just copy that member per 

drag-and-drop. 

4. Show or hide Divisions and Teams in the resources and workload overview as needed, and 

drag-and-drop a team into the overview.   

Please note It is not possible to create new departments (Divisions) in the workload overview. You 

can create, edit and delete departments in the InLoox Settings, if you have the necessary 

administrator rights. You can also allocate resources to departments.   

 

Add a new resource 
You can also add a resource without assigning it to a team from the outset:  

1. Go to InLoox >> Allocation 

2. Click on Add Resource in the Ribbon  

3. Select a resource from the address book, e.g. from the global address list or the InLoox 

address list. 

If you need a resource who has specific skills, then you can filter your address book by skills, so it only 

shows the resources who have these skills. To do so, click on Skills on the upper right-hand corner of 

the dialog window and select the skills you need. It is possible to select more than one skill.   

Please note When you filter by skills, all resources which have at least one of the specified skills are 

shown, not just the ones that possess all of the selected skills.  

Please note You can define Skills in the InLoox Settings and specify which resources in your company 

have which skills.  

     4. Confirm with OK. The new team member is sorted into the automatically created Standard 

Team. 

Tip If a team member works on several projects, then you can just copy that member per drag-and-

drop.  

 

Re-Assign a task 
Follow these steps to re-assign a task, i.e. to allocate a task from one resource to another: 

1. Expand all groups until you reach the tasks. To do so click on the arrow next to a group, then 

expand the resource, then expand the project. Or you can expand groups via the context 

menu. Note that this command only expands the next lower subordinate group, so you have 

to click on Expand All until you get to the lowest level, the tasks.  

2. Select the task you want to re-assign. 

3. Click on Re-Assign Task in the ribbon. 
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4. Select the resource you want to assign the task to from the address book. 

5. Click on OK to confirm.  

 

Change the date range 
The workload overview enables you to see the workload of your entire company, of a department or 

of an individual resource in a specific time frame. You can specify the date range as needed:  Today, 

Week, Month, Year, or a Custom date range.  

1. To specify a time frame click on Date Range in the Ribbon 

2. Select the required date range. The view of the workload overview changes depending on the 

chosen date range. 

 

The workload chart 
The workload chart below the resources overview shows you the cumulated workload data of your 

entire company, of a department, of a project team, or of an individual resource. It shows you a visual 

overview of the workload in the specified time range. The workload chart shows you the allocation of 

resources, depending on which group or resource you have selected from the resource list. This 

means that the workload chart is dependent on the resource overview. If you have not selected a 

group or resource from the resource list, then the workload chart won’t show any data.  

These rules apply to the workload chart:  

• A blue area shows that a resource is busy in the specified time frame, but not over-allocated. 

The height of the bars shows how busy a resource is in percent.  

• A striped blue area shows that a resource is over-allocated in the specified time frame. The 

height of the bars shows how busy – or over-allocated a resource is in percent. 

• You can immediately see when a resource is working to capacity from the horizontal blue 

line at the height of 100%. So, if the bars go over that line that means that a resource is over-

allocated in that time frame. 

• The horizontal green line shows the average workload of a team or resource. We 

recommend an average workload of 60-70%, as resources often have to do day-to-day 

business tasks in addition to project work. This way you ensure that your team members are 

not overworked. 

• A vertical blue line displays the current day. 

 

Support and contact options 

Contact the InLoox support team  

Thank you for choosing InLoox. 

Microsoft Outlook is a sophisticated software product that is underlies a continuous development 

process. Due to ongoing Office and security updates, Exchange Server service packs and new versions 
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of Windows, there are a great variety of user scenarios in which InLoox software solutions can be 

used. 

InLoox, Inc. develops and engineers the InLoox project management software solutions. Your project 

success is our priority and we greatly appreciate your feedback. Our customer's input inspires the 

continuous improvement of our software. The InLoox support team is happy to help you with 

technical issues that might arise and support you in finding the solution that best fits your business 

needs. We are happy to answer any project related questions you have.  

NOTE Please have your InLoox account number handy when contacting the support team. This helps 

us to provide better and faster support to you. You can find the InLoox account name in the InLoox 

settings. 

Internet: support.inloox.com 

E-Mail: support@inloox.com 

Technical Support: +49 (0)89 358 99 88 - 40 

Sales: +49 (0) 89 358 99 88 - 20 

Fax: +49 (0)89 358 99 88 - 99 

Software error messages 
We compiled a list of InLoox error messages that can pop up while working with the software, as well 

as recommended issue fixes and troubleshooting ideas. 

If you are having difficulties finding a solution for technical issues that you come across, 

please contact the InLoox support team. Or you can browse our online knowledge base for user 

instructions and tutorial videos at www.inloox.com/support/. 

Database errors 

Error message Recommended solutions 

Connection to the InLoox database 

has been interrupted. The 

connection will be restored as soon 

as possible. 

• Make sure that the network is accessible. 

• Check whether the offline configuration is set 

up correctly. 

• Contact the system administrator. 

You are using InLoox On-Prem 

version X.X. 

The InLoox On-Prem database 

version is Y.Y. 

Please make sure that you are using 

a compatible product version or 

contact your system administrator. 

The InLoox On-Prem client version you are using is not 

compatible with the database version on the server. 

Please update your InLoox On-Prem client version. 

https://www.inloox.com/support/documentation/online-help/inloox-web-app/11-0/all-topics-inloox-11-web-app/inloox-account-settings/rename-account/
https://www.inloox.com/support/documentation/online-help/inloox-web-app/11-0/all-topics-inloox-11-web-app/inloox-account-settings/rename-account/
https://support.inloox.com/
mailto:support@inloox.com
http://www.inloox.com/support/
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Software license errors 

Error message Recommended solution 

The product key you entered is not 

valid in combination with your 

current InLoox client version. 

The license key you entered is either only valid for an 

older InLoox version or for an updated version. 

A license error has occurred. Please 

make sure you entered the correct 

license key or contact your system 

administrator. 

The license key you entered is invalid for the InLoox 

version that is currently installed on your system. 

Please contact your system administrator for a valid 

license key. 

The maximum number of user 

clients has already been reached. 

You can not use InLoox. 

Please make sure you entered the 

correct license key or contact your 

system administrator. 

InLoox product keys are valid for the amount of user 

licenses you purchase. In this case, the number of 

available work station licenses has been exceeded. You 

can add new user licenses at any point. 

    

Reporting errors 

Error message Recommended solution 

The report template contains 

an error. An expression used 

in the template is incorrect. 

Please correct the report 

template. 

Please review the report template, using the support 

documentation for the InLoox report designer. 

The report contains no data. 

Empty reports cannot be 

created. 

Please edit the report 

template. 

No project information has been entered into the report. 

Tip Please edit the respective template. The 

chapter Managing Report Templates and the support 
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documentation for the InLoox report designer provide 

instructions on how to edit the template. 

No printer is installed. 

Please install a printer to 

print reports. 

A printer must be installed in order to print a report. Please 

install the required print driver. You'll find detailed 

information in the user manual of your printer. 

    

 

Time tracking 
With the time tracking feature in InLoox you can record time exposure for project-related tasks, 

document activities or track working hours for accounting. You can create time tracking entries either 

within an open project or in the time tracking overview. Both views allow you to create and edit time 

tracking entries or to create a reminder. 

• The time tracking overview is located outside of the projects and shows the time tracking 

entries of all projects you are allowed to access. 

• Whereas the time tracking view within a project just shows the time tracking entries of that 

project. 

 

Create and edit time tracking entries 
This chapter explains how to track working time in InLoox. The system automatically assigns the effort 

to the project plan and stores a separate cost record. 

You can create a time tracking entry either directly in the project, or in the project overview: 

  

Create and edit time tracking entries within a project 
1. Open an already existing project. 

2. In the project open the Start tab and click on Time to open the time tracking view of your project. 

3. The time tracking view shows all time tracking entries of a specific project. To create a new time 

tracking entry, click on New. 

4. A side panel will open on the right side. Here you can add all important information regarding the 

new time tracking entry: 
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• Basic Information: Here you can choose between the modes Started at, Ended at or Start 

and End. Fill out the parameters accordingly. In addition, add the name and a brief 

description of the activity you were working on. 

• Assignment: Assign the time tracking entry to a specific task or an activity. If you assign it to 

an activity, the drop-down-list will represent the structure of the planning. Assign a cost 

group to the entry by editing the field Group.  

• Details: Mark the new time tracking entry with a green, yellow or red flag and choose the 

resource that performed the activity or task. 

• Documents: Add additional documents, if needed. 
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5. When you have added all important facts, close the side panel by clicking on  the icon next to Basic 

Information in the right corner. Your changes have been saved already. 

6. To edit an already existing time tracking entry, double-click on the entry in the time tracking view 

of your project. Alternatively, select the entry in the time tracking list and click on  Edit on 

the Edit tab. Alternatively, click on the entry once and then on Edit Time on the right side. The side 

panel will open up again on the right side and you can edit the information of the entry you have 

selected. Then close the side panel and your changes will be saved.   

    

Create and edit time tracking entries in the time tracking overview 
Even faster you can create time tracking entries in the time tracking overview over all projects:  

1. Start on the project overview. Select Time from the bottom navigation to go to the time tracking. 

 

2. This time tracking overview contains all time tracking entries of  all projects.  

3. In the Start tab click on New time entry, to create a new time tracking entry. 

4. A dialog box Edit Time will open on the right. Add all information and follow the procedure that is 

described above in Create and edit time tracking entries within a project. Additionally, select the 

project to assign the new entry to a project.  

5. When you have added all information, click on the Save Button in the upper right corner.  

6. To edit an already existing time tracking entry, double-click on the entry in the time tracking 

overview. Alternatively, you can select it in the list and click on Edit in the Start tab. The dialog 

box Edit Time will open and you can edit the information of the entry. Afterwards click on the Save 

Button in the upper right corner.  

 

Customize time tracking views 
The time tracking view within a specific project provides an overview over all time tracking entries of 

the project. Whereas the time tracking overview over all projects displays all time tracking entries 

of all projects. Both views can be individually customized regarding your personal needs.  

Analytical filter 

The analytical filter provides advanced options to easily find information and structure the time 

tracking view. To open the analytical filter click on … 

• … Filter on the Start tab. (time tracking overview over all projects) 

• … Edit Filter on the View tab. (time tracking view within a project) 
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Costumize columns in the table view 
In the time tracking views you can add various additional information by adding more column 

headings. 

1. To add new column headings, either right-click and choose Select fields,  

 

 or navigate to Select Fields in the View tab. 

 

2. A new dialog box that displays all available fields will open.  
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If you want to add one of the fields to your list, drag it to your preferred location in the list. Two 

arrows indicate the position of the new column.  

 

3. To delete a column heading from the list, drag the field back into the dialog box or into the 

empty area below the list. 

  

 

Group feature 
1. To group time tracking entries by a specific column, drag a column header into the field 

directly above the column headers. In this example, we group by the person who performed 

the task/time entry.  
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2. By clicking on the arrow next to the group criteria, you can change the order from ascending 

to descending or the other way round. 

3. Here you can use an additional filter option: Move the cursor over the group criteria. A  filter 

icon appears in the right corner. Click on that icon to further limit the criteria, e.g. by certain 

values or date ranges. 

 

   

  

Sort time tracking entries 

You have the possibility to sort time tracking entries by column headings: 

1. Click on the column heading. 

2. Then click again to change the sorting order.  
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Save customized views 
After you have customized your time tracking views regarding your personal needs, you can save 

those views for a later time. 

• The time tracking view within a project automatically saves your adjustments. When you are 

opening the project the next time, your customized view will be automatically displayed.  

• In the time tracking overview over all projects, you can save your customized view well. In 

addition, you can make it accessible for other users by saving a customized view. How to save 

your customized view in the time tracking overview over all projects will be explained in the 

following step-by-step. 

   

Save a customized view in the time tracking overview over all projects 

1. Start on the project overview. Select Time from the bottom navigation to go to the time 

tracking. The time tracking overview over all projects opens. Customize the view regarding 

your needs (For more information on that topic read Customize time tracking views).  

2. To save the customized view, open the View tab and click on Save view or Save as new view. 

 

3. Name the view (e.g. “Grouped by projects”) and activate the check box Visible for all users, if 

you want to make your view accessible for other users. Then click on OK. 

 

4. You can find the view in the tree structure on the left side directly below time.   

 

 


